
About Home Plan Pro
See also About CAD

Home Plan Pro is designed to quickly and easily draw high quality floor plans, site plans, and 
architectural designs.

Home Plan Pro provides a full array of graphic tool buttons to let you easily pick a tool or action. Once you
choose a tool, Home Plan Pro tells you how to use it. You may use the mouse or keyboard, or both, to 
create your plan.

Home Plan Pro gives you many choices for printing your plans. You may select a specific scale, or elect 
to have your plan printed at the largest size that will fit on the paper you select.

While there are a number of impressive and powerful CAD programs available, they are more difficult to 
learn and use than Home Plan Pro. To preserve its intuitive ease of use and low cost, Home Plan Pro is 
not designed to compete with full-fledged CAD programs.

Home Plan Software
8437 Center Street
Mokelumne Hill, CA 95245
Voice: 209 286 1021
Fax: 209 286 1319

Orders:
http://www.homeplanpro.com/order.html
Voice: 800 903 4152    
Fax: 724 850 8187
ask for product # 171598        



"Windows" Menu
Available on the Main Menu

When you load a second plan, the first plan is kept in memory and added to the "Windows" menu.    You 
can click on any plan in the "Windows" menu to switch to it.

When you quit Home Plan Pro, the program remembers all the loaded plans and reloads them so they 
are all in the "Windows" menu each startup.

You can click the "Remove All Inactive Plans" item at the top of the menu to remove all but the current 
Plan from the program and from the menu.
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Status bar

The Status Bar shows the 
Odometer
Line Length
Line Angle
Screen Resolution
Make Plan Fit Screen
Click on a Spot to Zoom
Move Plan to Upper Left
Line attributes
Snap Grid
Speed  (distance Number Pad move cursor



Select an Element
Hint: It's faster and easier to click the right-mouse button on a single drawing element to select it.    Use 
the Selection tool only if you want to select multiple elements.

· Click the Select Element tool; the cursor changes to an arrow.
· Click near the edge of an element.    Or press Enter with the cursor positioned on the element.    (Pre-

drawn figures select better from the center, bezier curves from their ends.)

NOTE: The first element found at the cursor location will be selected. 
To select another element occupying the same location, press the F3 key or select "Search For Another 
Element at This Location" from the right-click popup menu.

· If you click a different element, it will be selected and the previously selected element will be un-
selected.

· If you want to keep the selection and add to it, Hold down the Shift key while clicking another element.

When selected, the element turns magenta in color and the Alter Plan tool bar appears (to the right of the 
main tool bar).    While options vary according to the element selected, in general it can be:

·        Cut or copied
·         Moved
·         Rotated
·         Resized
·         Flipped horizontally
·         Flipped vertically
·         Change Color
·         Line Style
·         Fill Pattern
·         Change Properties
      
 Click to un-select the element.    (Press Enter if using arrow keys.)

Alternative: Right-clicking on a drawing element will select that element and produce a pop-up menu with
items pertinent to the type of element selected.

Also see: How To Select A Group Altering Drawing Elements

Turn the Snap Grid off, or you may not be able to get close enough to the edge of an element to select it.

Note: Bezier curves are selected by clicking on the ends of the curve. You cannot select a curve by 
clicking on it's surface.

When all selected elements are of the same type, additional options are available.
For instance:
If all selected elements are walls, you can do things that pertain to walls, like changing the wall thickness 
or the fill pattern. All selected walls will reflect these changes.

If all the selected elements are text, you can change the font specifications for all the selected text 
elements.

But, if the selected elements are of different types - i.e. some are walls, some are text - then you are 
limited to operations that can be performed on any element like moving, copying, etc.





System Requirements

Home Plan Pro requires a computer running Windows 95/98/NT/2000/XP/Vista/Windows 7.
To print plans drawn with this application, you need a graphics capable printer installed in the Windows 
system.

Almost any printer likely to be used with a desk top computer is graphics capable, so if you have a 
machine running Windows 95/98/NT/2000/XP/Vista/Windows 7, and a printer, you are probably ready to 
use Home Plan Pro.



Installation and Uninstallation

Since you are reading this help file, it is likely that you have successfully installed Home Plan Pro.

Home Plan Pro is installed by running a self-extracting file. The self-extracting file is usually called 
Hppro.Exe, but may have a name such as Setup.Exe .

During the installation, you can change the default destination directory and the location for the program 
icons.

The installation was non-destructive.    All files were added only to the destination directory that you 
chose.

Uninstalling Home Plan Pro

To Uninstall Home Plan Pro from Windows 95: 
From the Device Manager, select: Install / Uninstall Programs or Add / Remove Programs
Select Home Plan Pro and click on Next.

Note: Windows removes only the files originally installed, and doesn't remove folders if there are files 
remaining.    That means that if you have used the program and made data or configuration files, you 
need to manually delete them to remove all traces from your system.



Drawing Tools
See also: Snap Grid
Click on one of the tool bar buttons for instructions in it's use.
Note: Brief instructions appear in the top Prompt Bar.

During program operation, you can right-click any of these buttons to get illustrated help on the 
tool's use.



Prompt Bar

After selecting a drawing tool, and during its use. prompts appear in the Prompt Bar.

You can turn the Prompt Bar off, to get more screen room, when you feel you don't need it any longer.



Select A Group

    See also Select by Element Type

· Click the Select Group tool. The cursor becomes an arrow.
· Click and draw a box around elements to be selected, then click again.    Or position the cursor, press 

Enter, use the arrow keys to draw the box, then press Enter.
· When selected, the elements turn magenta in color and the Alter Plan tool bar appears (to the right of 

the main tool bar).    While options vary according to the elements selected, in general they can be:

· Cut or copied
· Moved
· Rotated
· Resized
· Flipped horizontally
· Flipped vertically
· Change Color
· Line Style
· Fill Pattern

        Click to un-select the element.    (Press Enter if using arrow keys.)

More Info:
      ·  Only those elements entirely within the box are selected.    This action can be changed in 
Preferences under General.

Also see: Select An Element Altering Drawing Elements

When all selected elements are of the same type, additional options are available.
For instance:
If all selected elements are walls, you can do things that pertain to walls, like changing the wall thickness 
or the fill pattern. All selected walls will reflect these changes.

If all the selected elements are text, you can change the font specifications for all the selected text 
elements.

But, if the selected elements are of different types - i.e. some are walls, some are text - then you are 
limited to operations that can be performed on any element like moving, copying, etc.



Draw a Line

Keyboard access: "L"

Select the Line tool. Esc to quit.
 
With the mouse:
· Click to begin drawing a line.
· Click to end drawing the line.

With the keyboard:
· Position the cursor at the point at which the line is to begin.
· Press Enter.
· Move the cursor with arrow keys to the end of the line.
· Press Enter.

Press Escape to quit drawing a line

Continue drawing lines or select another tool.

More Info
· Lines are adjusted to level or plumb.
· To draw a line at an angle with the mouse, hold the Shift key down and draw as above.
· To draw a line at a 45 degree angle, follow the procedure above for drawing with keyboard, but use 

the 1, 3, 7, or 9 keys in the number pad.
· For better precision, use the arrow keys to position the cursor at the endpoints of the line.
· Line length is shown in the Odometers at the left of the Status bar.
· The keyboard arrow keys move the cursor one pixel at a time.
· The Number Pad arrow keys move the cursor the distance assigned.    Adjust this distance by 

pressing the Plus and Minus keys.    The current distance is reported on the far right of the status bar.
· To connect the cursor to the end of an existing line, move close and press the Period key.
· See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element
Use the Select Line Style button to choose a new line style.



Select Line Style

The easiest way to change the Line style, is to press the Space Bar while watching the linestyle box in the
Status Bar. 

If you prefer to use the    line style bar, you can turn it on from the View Menu

It sits on top of the status bar. It takes up some drawing real estate, so you might want to keep it hidden 
and use the space bar.



Draw A Polygon

        Select the Polygon tool. Esc to quit.

With the mouse:
· Click the point at which to begin.
· Click points as needed to draw additional sides.
· After clicking the last point, click again to close and complete the polygon.

With the keyboard:
· Position the cursor at the point at which to begin.
· Press Enter and move the cursor with the arrow keys to the end of the side.
· Repeat the above for each side.
· Press Enter to end drawing to the last point.
· Press Enter again to close and complete the polygon.

        Continue drawing polygons or select another tool.

More Info
· The sides of the polygon are adjusted to level or plumb.

· Hold the Shift key down to draw lines at an Angle with the mouse.

· To draw at a 45 degree angle, follow the procedure above for drawing with the keyboard, but use the 
1, 3, 7, or 9 keys in the number pad.

· For better precision, use the arrow keys to position the endpoints of the sides of the polygon.

· Line length is shown in the Odometer at the left of the Status bar.

· The keyboard arrow keys move the cursor one pixel at a time.

·  The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing the 
Plus and Minus keys.    The current distance is reported on the far right of the status bar.

· See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Draw a Rectangle

Keyboard access: "R"

        Select the Rectangle tool. Esc to quit.

With the mouse:
· Click a point at which a corner of the rectangle is to be located.
· Click the corner opposite.

With the keyboard:
· Position the cursor at a corner of the rectangle.
· Press Enter.
· Move the cursor with the arrow keys to the opposite corner.
· Press Enter.

        Continue drawing rectangles or select another tool.

More Info:
· The sides of the rectangle are adjusted to level or plumb.
· To draw a square, follow the procedure above for drawing with the keyboard, but use the 1, 3, 7, or 9 

keys in the number pad.
· For better precision, use the arrow keys to position the corners of the rectangle.
· The Dimensions of the rectangle are updated in the Odometers at    the left of the status bar as it is 

drawn.
· The keyboard arrow keys move the cursor one pixel at a time.
· The Number Pad arrow keys move the cursor the distance assigned.    Adjust this distance by 

pressing the Plus and Minus keys.    The current distance is reported on the far right of the Status bar.

See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Draw An Arc

Keyboard access: "("

        Select the Arc tool. Esc to quit.

With the mouse:
· Click at the beginning of the arc.
· Click at the end of it.
· Drag the cursor on the arc as needed.
· Click to end.

With the keyboard:
· Position the cursor at the beginning of the arc.
· Press Enter.
· Move the cursor with the arrow keys.
· Press Enter at the end of the arc.
· Drag the cursor on the arc as needed.
· Press Enter.

        Continue drawing arcs or select another tool.
        
More Info
· For better precision, use the arrow keys to locate the endpoints of the arc.

· Line length is shown in the Odometer at the left of the Status bar.

· The keyboard arrow keys move the cursor one pixel at a time.

· The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing the 
Plus and Minus keys.    The current distance is reported on the far right of the status bar.

· See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element

1.    Left click at the first end of the arc.
2.    Left click at the other end of the arc.
3.    Move the cursor and Left click When the arc is correct

Continue drawing arcs or switch to another tool.



Draw a Circle Or Ellipse

Keyboard access: "C"

        Select the Circle tool. Esc.

With the mouse:
· Click the point that is to be the center of the ellipse.
· Move the cursor as needed to adjust the size and shape.
· When the ellipse is correct, click again.
· If needed, drag the ellipse to the correct position.
· Click to end.

With the keyboard:
· Position the cursor at the point which is to be the center of the ellipse.
· Press Enter and move the cursor with the arrow keys to adjust size and shape.
· Press Enter to end.
· If needed, drag the figure to the correct position.
· Press Enter.

        Continue drawing circles or ellipses, or select another tool.

More Info
        · To draw a circle with the mouse, hold the Shift key down, then follow the procedure above.
        · To draw a circle with the arrow keys, follow the procedure above, but use the 1, 3, 7, or 9 keys in 
the number pad.

        · For better precision, use the arrow keys to position the center and create the figure.

        · Line length is shown in the Odometers at the left of the Status bar.

        · The keyboard arrow keys move the cursor one pixel at a time.

        · The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing 
the Plus and Minus keys.    The current distance is reported on the far right of the status bar.

      · See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Draw A Wall

Keyboard access: "W"
        
        Select the Wall tool. Esc to quit.

With the mouse:
· Drag from the beginning point to the end.
· Click to end.

With the keyboard:
· Position the cursor at the point at which to begin.
· Press Enter and move the cursor with the arrow keys to the end of the wall.
· Press Enter.

        Continue drawing walls or select another tool.

More Info:      
· To draw a wall at an angle with the mouse, Press the Shift Key after beginning to draw.

· To draw a wall at a 45 degree angle, follow the procedure above    for drawing with keyboard, but use 
the 1, 3, 7, or 9 keys in the number pad.

·  For better precision, use the arrow keys to position the endpoints of the wall.

·   Use the space bar to "flip" the wall to the other side of the cursor.

·     Under Preferences, select the Wall tab to customize walls

·  Line length is shown in the Odometer at the left of the Status bar.

·  The keyboard arrow keys move the cursor one pixel at a time.

·     The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing the 
Plus and Minus keys.    The current distance is reported on the far right of the status bar.

    See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element





Draw A Scalable Pattern

 See also Scalable patterns versus Filled polygons

· Select the Scalable Patterns button.
· Select a pattern, line color, and fill color to use.

Click the Rectangle button to draw a filled rectangle
Click the Polygon button to draw a filled polygon
Click Cancel to Quit.

 
More Info
 Use the Framing pattern for floor joists and wall elevations.    The rectangle is filled with framing 

members across the shortest dimension.

· Framing & siding patterns can be either horizontal or vertical.

·  Line length is shown in the Odometers at the left of the Status bar.

·  For better precision, use the arrow keys to position the corners of the rectangle.

· Line length is shown in the Odometesr at the left of the Status bar.

· The keyboard arrow keys move the cursor one pixel at a time.

·  The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing the 



Plus and Minus keys.    The current distance is reported on the far right of the status bar.

· See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Scalable Pattern Display

Click on a Scalable Pattern in the pattern list to see a dipiction of that pattern using the current 
dimensions for that pattern.



Scalable Pattern Dimensions
Scalable pattern dimensions can be adjusted.

Different patterns provide different dimension settings:

Framing: Framing spacing & Framing thickness
Siding:  Width of Siding exposure
Blocks:  Width & height of blocks
Bricks:  Width & height of bricks
Tiles:   Width & length of tiles
Shingles:Width & height of shingle exposure



Draw a Door

Keyboard access: "/"

        Select the Door tool. Esc to Quit.

With the mouse:
· Begin dragging at the position of the hinged edge of the door.
· End dragging and click the position for the edge of the door that is to latch.
· Click a position in the direction the door is to open.

With the keyboard:
· Position the cursor at the hinged edge of the door.
· Press Enter and move the cursor with the arrow keys to the edge of the door that is to latch.
· Press Enter and move off the door in the direction in which it is to open.
· Press Enter.

        Continue drawing doors or select another tool.
        
More Info
·         To draw a door at an angle, release the button after beginning to drag.

·        For better precision, use the arrow keys to position the edges of the door.

·        Under Preferences, select the Doors tab to set an option for doors to open to other than 90 degrees
and another to omit the door's dimensions when printed.

·        Line length is shown in the Odometers at the left of the Status bar.

·        The keyboard arrow keys move the cursor one pixel at a time.

·        The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing 
the Plus and Minus keys.    The current distance is reported on the far right of the status bar.

       See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Draw A Window
Keyboard access: "G"

        Select the Window tool. Esc to Quit.

With the mouse:
· Begin dragging at one edge of the window.
· Click at the other edge.

With the keyboard:
· Position the cursor at one edge of the window.
· Press Enter and move the cursor with the keyboard arrow keys to the other edge.
· Press Enter.

        Continue drawing windows or select another tool.

More Info:
·         To draw windows at an angle with the mouse, release the button after beginning to draw.

·          For better precision, use the arrow keys to position the edges of the window.

·          The width of the window is shown in the Odometers at the left of the Status bar.

·          The keyboard arrow keys move the cursor one pixel at a time.

·          The Number Pad    keys move the cursor the distance assigned.    Adjust this distance by pressing 
the Plus and Minus keys.    The current distance is reported on the far right of the status bar.

       See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Insert Text
See also Fast_Text  Text Scaling

Keyboard access: "T"

        Select the Text tool. Esc to quit.

· Enter text or select from the pre-assigned text buttons.
· Select color, font attributes, and orientation as needed.
· Click Ok to place text on the workspace.
· Drag to position the text and click.    Or move the text with the arrow keys, then press Enter.

To enter additional text, select the Text button again. Or select another tool.

More Info:
· Multiple lines of text can be entered, but each is treated as a separate element of the drawing.

· When a Reserved word such as LastSaved is entered, the date the plan was last saved is updated 
when printed.

· For further details, and other such terms, Please see Reserved Words.

· The keyboard arrow keys move the cursor one pixel at a time.

· The number pad arrow keys move the cursor the distance assigned.    Adjust this distance by pressing 
the Plus and Minus keys.    The current distance is reported on the far right of the status bar.

To edit the text later, select the line you wish to edit, and click the Alter Plan Text button.



Insert a Dimension

Keyboard access: "D"

        Select the Dimension tool. Esc

With the mouse:
· Click where you want the dimension to start.
· Click where you want the dimension to stop.
Note: you can also "drag" the mouse, holding the button down and then release the button where you 
want the dimension to stop. 

With the keyboard:
· Position the cursor at the point from which to begin measuring.
· Press Enter and move the cursor with the arrow keys to the point at which to end measuring.
· Press Enter.
        
More Info
·          Dimensions are adjusted to level or plumb.    

·           To draw dimensions at an angle with the mouse, press the Shift key after starting a dimension.

·          The length of the dimension is shown in the Odometers at the left of the Status bar.

·          A dimension may be too short to report the length properly.    In some cases, it will not report on 
the screen but will print correctly.

·          For better precision, use the arrow keys to locate the endpoints of the distance to be measured.

·          Under Preferences, select the Dimension tab to customize the dimensions used.

·          The keyboard arrow keys move the cursor one pixel at a time.

·          The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing 
the Plus and Minus keys.    The current distance is reported on the far right of the status bar.

· To alter an element already drawn, see: How To Select An Element



Draw A Filled Area
See also: Alter Fill Pattern

        Select the Fill Area tool. Esc to quit.

· Select a fill pattern or color.

With the mouse:
· Click the point at which to begin.
· Click points as needed to draw additional sides.
· After clicking the last point, click again to close and complete the filled area.

With the keyboard:
· Position the cursor at the point at which to begin.
· Press Enter and move the cursor with the arrow keys to the next point.
· Repeat the above for each side.
· Press Enter to end drawing at the last point.
· Press Enter again to close and complete the filled area.

        Continue drawing filled areas or select another tool.

More Info:
· Sides of the polygon are adjusted to level or plumb.

· Hold the Shift key down to draw lines with the mouse at an angle.

· To draw at a 45 degree angle, follow the procedure above for drawing with keyboard, but use the 1, 3,
7, or 9 keys in the Number Pad.

· When selecting a fill pattern, the patterns at the top of the screen are standard Windows patterns.

· The patterns at the bottom of the screen are custom patterns. They use the line color in effect at the 
time they are selected.

· For better precision, use the arrow keys to position the endpoints of the sides of the polygon.

· Line length is shown in the Odometers at the left of the Status bar.

· The keyboard arrow keys move the cursor one pixel at a time.

· The Number Pad keys move the cursor the distance assigned.    Adjust this distance by pressing the 
Plus and Minus keys.    The current distance is reported on the far right of the status bar.

 See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Insert A Pre-drawn Figure

    Keyboard access: "F"
See Also:      Resize figures Rotate Figures Recently Used Figures

        Select the Insert Figure tool. Esc to quit

· Select Pre-Drawn Figures, Pre-Drawn Symbols, or Windows and Doors by clicking the appropriate tab.
· Select a figure library from the buttons on the left.
· Click to select a figure.
· Drag the figure to the appropriate location. Or use the arrow keys to move it.
· To rotate a figure, right click while dragging it.
· Resize the figure by right-clicking it in the menu or use the Plus and/or Minus keys while dragging it in 

the drawing area.
· Click to anchor the figure.
        
To insert another figure, click the Insert Figure tool again and repeat the above.    Or select another 
drawing tool.

More Info:
· When you have clicked the Multiple Copies checkbox, double click or press Esc to end inserting 

duplicate figures.

· For better precision, use the arrow keys to position the figure in the workspace.

· The position of the figure within the workspace is updated at the left of the status bar as it is moved.

· The keyboard arrow keys move the cursor one pixel at a time.

·  The Number Pad    keys move the cursor the distance assigned.    Adjust this distance by pressing the 
Plus and Minus keys.    The current distance is reported on the far right of the status bar.

To alter an element already drawn, see: How To Select An Element



Hide an Area

Use this tool to outline an area which will be covered up with the background color.

Drawing elements hidden with this tool are not deleted, but merely hidden behind the covered area.

Hint:  When hiding a line, start a few pixels to one side of the line, and finish a few pixels on the other 
side. This will take care of any variations caused by drawing in different zooming sizes.



Clone Drawing Elements

Click this button, and Left click anywhere on the plan where you want a copy of the last drawing element.

Hint: You can select any element and use the "Send to Front" menu item to make that the last drawing 
element.



Drawing Navigation
See also Zooming Mouse Wheel Scrolling Keyboard Access Scroll Bars

Located at the bottom of the left hand toolbar is either the "Zoom box". or the Viewport Navigator. Use the
Preferences screen to select which you want to use.

Click on one of the rectangles to view the corresponding area of the plan.
------------------
Mouse:
· When the mouse approaches the screen edge, press the Ctrl key to scroll the plan.
· To avoid having to press Ctrl, set that option on the Preferences Drawing tab.
· Click on the horizontal or vertical scroll bar.

Keyboard:

The easiest way to scroll with the keyboard, is to move the cursor near the edge of the visible part of the 
drawing.
The plan will continue to scroll as you progress towards the edge, until it is at the end of the drawing. This
works even when you are drawing lines or other drawing elements.

Other keyboard scroll tools:
· Hold down the Ctrl key and press an Arrow key to shift the plan slightly
· Press Page UP to shift the plan a full page up
· Press Page DN to shift the plan a full page up
· Use the Shift key with the above to shift horizontally.

· Press HOME to go to the upper left corner
· Press END to go to the bottom right corner



Altering Drawing Elements
After one or more drawing elements have been selected,
these buttons appear on the top toolbar:

Alternative:  Right-clicking on a drawing element will select that element and produce a pop-up menu 
with items pertinent to the type of element selected.

Note: Depending on the type of element selected, the button with the fill patterns may have a different 
graphic and different function:

See also Zorder Clip Files



Cut Drawing Elements
    Keyboard access: Delete key

Accessed from the Alter Plan Toolbar

When cutting drawing selected elements from your plan, you can elect to simply discard them, or to save 
them to a buffer to be used later in this or another plan.

Use the Edit Menu's Paste from Buffer to paste the selection in a plan.



Printing hints
See    also Printing Problems

· Select Black and White to save colored ink.
If you use a color printer, you know how fast those color cartridges run out of ink.

Fix:
To save on colored ink, use the Options/Black and White setting until the final printout.
____________________
· Printout too small
A common report is that printouts don't "fill the paper". This condition is an indication that there is a 
drawing element somewhere beyond the area you consider to be the plan.
Commonly, it is an erasure, or a tiny dot that is hard to see, but that nevertheless, convinces Home Pro 
that it needs to be printed. 
The actual plan has to be made smaller In order to fit this unwanted drawing element on the paper.

Fix:
We need to get rid of the unwanted drawing element. 
1. Use the Group Selection tool to select only the main drawing
2. Paste that into a new plan. 
This should leave the unwanted drawing element behind and solve the problem.
____________________
· Printout lines hard to see
Printers with a very high resolution, may draw very thin lines. This is because that by default, each line is 
one pixel wide. If you want to print at much over 300 DPI, you should adjust the Print Line Boldness.

Fix:
Go to the Printing tab on the Preferences form and select a degree of Print Line Boldness.
It's best to select an odd number, so the line will be centered. i.e.. 3x or 5x will draw lines three or five 
pixels in width.
____________________
· Entire printout hard to see
Some Printers have a problem printing colors. You can check the "Black and White" setting on the 
Options menu to see if that is the case with your printer.

Fix:
If it prints normally in black and white you need to change the colors to black. Select groups of elements 
and click the Color button on the Alter Plan tool bar.
____________________
· Printed text too big or too small
You probably don't want the text in your plans to be scaled the same as all the other drawing elements. A 
small plan at a large scale would have overpoweringly large text, and a large plan at a small scale may 
have unreadable text.

Fix:
Go to the Printing tab on the Preferences form and select a    Text Size Factor that provides the printed 
text size you prefer.



Move Drawing Elements
      Version 4.5.26 introduced changes in moving selected drawing elements.

You can move selected drawing elements to a new location.

A highlighted box is drawn around the selected drawing elements.
When the cursor is placed over the selection box, it changes into the four-headed arrow cursor shown 
above.

When this cursor is displayed, you can hold the left mouse button down and drag the elements to a new 
location, using the mouse or the arrow keys.
· The Arrow Keys always move the cursor one pixel at a time. Great for precision, but slow.
· The Number Pad keys move the cursor faster.

Note: You can use the mouse and the keyboard at the same time, but you must hold down the left 
mouse button even when using the keyboard. The selection will not move unless the left mouse button is 
depressed.

Release the mouse button to anchor the selection and draw it in the new location.
Repeat until the position is correct. 

To end the moving process Do one of the following:
· Double click on a blank area of the drawing
· Press Escape
· Select another drawing tool.



Rotate Drawing Elements

You can rotate selected drawing elements, after selecting the direction and degrees to rotate.

To de-select the rotated elements, Double click on an empty area.



Re-size Drawing Elements

See also:
· Re-size Selection by Percentage
· Re-size Entire Plan by percentage
You can resize a single selected drawing element, or a group of selected elements.

A box with "handles" appears around the selection.
When the cursor is over a handle, it turns into a double headed arrow, indicating the direction to drag.

· Drag the edge or corner to change the size.
· Drag a corner to keep the original aspect ratio.
· Double click on an empty area when done resizing



Flip Drawing Elements Horizontally

This routine "swaps ends" with the right end becoming the left end.

Select one or more drawing elements, and click the Flip Horiz button.

See also Flipping Predrawn Figures



Flip Drawing Elements Vertically

This routine causes the top of the selection to become the bottom.

Select one or more drawing elements, and click the Flip Vert button.

See also Flipping Predrawn Figures



Change Drawing Element Color

See Also Edit Plan Colors      Line Attributes      Choosing Colors

You can select a new drawing color for selected elements.

Select an Elementa new color, and click OK.

The new color won't become apparent, until you close the selection, removing the highlight color.



Alter the Fill Pattern

You can change the pattern in previously filled shapes, or add a pattern to an empty shape.
Click on the fill and color you want to use.

Note:    When selecting a fill pattern, the patterns at the top of the screen are standard Windows patterns.
The patterns at the bottom of the screen are custom patterns. They use the line color in effect at the time 
they are selected.



Cancel Alter Plan Changes

You can revert to the original plan, if you aren't happy with the changes you have made.

This cancels all changes made since the last selection. Do not confuse this with the Undo / Redo button 
on the drawing tool bar.



Close Alter Plan Toolbar
Removes any elements from the Selection List, and closes the Alter Plan Toolbar.

When drawing elements have been selected, the Alter Plan toolbar becomes activated.

The last button on the Alter Plan toolbar causes the toolbar to become deactivated.
You can also use the Escape key.



Alter Text Elements
You can change the font attributes, color, and direction as well as edit the text content.

When a single text element is selected, this button appears on the top tool bar.
Click it to edit the selected text



File Operations
Open,    Save,    Create Plans and Clip Files.

File operations for opening, and saving plans are the same as your other Windows programs.

If you attempt to open a plan made with an earlier (Dos) version, you will be prompted with a name that 
will be used to back up the original. The next time you save the plan, it will be converted to the new 
format.

See also: Open Plan New Plan Clip Files Export



Search For Plan Files
Access from the Drawing Screen File Menu

Click a button to search:

· Documents folder 

· Program folder

or select any drive or folder.

Your plan files will appear in the list.

When the search is done, double-click a file from the results list to load it.



Clip Files
You can save selected drawing elements to disk for reuse. They are called Clip files.

· Select a Group of drawing elements.
· Click on Save Selected to Clip File from the File Menu
· Type a descriptive name so you will recognize it later

· To load a clip file:
· Click on Load Clip File from the file menu.
· Select a clip file by name
· The clip file is loaded, selected, and ready for you to move into position.



Printing Your Plans
see also: Custom paper sizes PrintScale Print to Scale Printing Problems Printing hints      
Print Manager Print Preview        Print Snapshot      Printing Margins

Home Plan Pro uses your Windows printer driver to support all the features and paper sizes available to 
you.

The plan is shown at the scale that fills the selected paper.
Change the paper size or orientation to see the maximum scale afforded by all options.

Nominal print scales are available by clicking on the radio buttons.
Scales that result in a plan larger than the paper are disabled. 

See also Faxing your plan.



Preferences

Many settings are available to customize the way Home Plan Pro works and draws your plans.
Click on one of the tabs to see the options available.



Preferences Startup

Load Last Plan on Startup  turn this on if you want to always start up with the last plan you were working
on.

Turn Numlock On When Starting    If you have a Number Pad on your keyboard, Home Plan Pro can 
use those keys to move the cursor at a user set distance. This setting makes the numberpad act like 
Numlock is always on when in Home Plan Pro.

Some Laptops combine the numbers with text keys, and turning Numlock on is inconvenient.
Leave this on unless it's causing you problems.

Create Home Plan Pro Icons You can make or remove    icons on your desktop, start menu, or startup 
folder.
Note: making an icon in the Startup Folder will cause Home Plan Pro to automatically start up each time 
you boot your computer.

Associate Plan Files with Home Plan Pro    Use this button to tell Windows to start Home Plan pro and 
load the appropriate plan when you double click on a plan (.pln) file in MyComputer or Explorer.



Preferences Drawing

Connect Lines When Close When this option is on, and you start a new line within ten pixels from the
end of a previous line, the lines are automatically connected. This can be a big convenience, and a big 
inconvenience when you want to draw separate lines in a confined space.
However you have this set, you can temporarily reverse the setting by holding down the Ctrl key when 
you start the line.

Draw Level/Plumb Lines When this option is on, the lines for many drawing elements will be kept 
horizontal or vertical despite the mouse veering off a bit.
When this option is off, the lines will go wherever the cursor goes.
However you have this set, you can temporarily reverse the setting by holding down the Shift key as you 
draw the line.

Scaling Text to Drawing Size
· Automatic This is the default. Home Plan Pro decides
· Never Scale Text  text stays the same font size regardless of the drawing scale.
· Always Scale Text causes text to grow in proportion to the rest of the drawing.

Related item: Text Size Factor on the Preferences Printing Tab.

Space Between Parallel Lines and Double Walled Rectangles

Set the distance to be used between parallel lines and double walled rectangles
Check the box if you want the beginning of first set of parallel lines to be closed.
(Press the Control key while terminating the last segment if you want its end closed)

Select Each Element After it's Drawn    When this box is checked, each drawing element will be 
selected after drawing it.    You can use the Alter Plan toolbar to manipulate it before drawing the next 
element.    It will be de-selected when you start the next element.



Preferences General Tab

Use Full Screen Cross Hairs toggles the use of these supplements to the cursor    (F5)

Top tool bar visible you get more room by hiding the tool bar, at the cost of easy access to some of the 
features. 

Prompt Bar visible when you have the hang of the drawing operations, you might want to hide the 
prompt bar to gain some screen room

Selection Mode When you draw a box around elements to select them, you can select only elements 
that are entirely in the box, or all that have any part of them in the box.

Send Error Message Alerts  You can send alerts to Home Plan Pro support when errors occur. Clear 
this box to turn this feature off

Log Drawing Time Turn this on to make a log file to keep track of your time on individual plans. You can 
also specify how many entries you want to keep. The oldest entries over that number are purged.

Drawing Cursor Select a cursor to use for drawing. Test it in the box to the right.

Default Drawing Tool    Normally, the Line tool is active on startup and after you quit using a different 
tool.
You can elect to have no tool active in these circumstances, requiring you to select a tool button, or you 
can elect to have one of the Selection tools be the default.

Show Plan Size Dialog
You can have the Plan Size Dialog come up when you start a new plan, or bypass that dialog for a blank 
screen at the default zoom level.



Preferences Dimensions
Specify how you want dimensions to appear on the plan.

USA/Metric options specify the units of measurement to use in dimensions
(this does not switch between modes)

Dimension Fonts select the font size and attributes to use in dimensions.

Dimension text    You can specify whether you want the dimension numbers to be:
· In-line with the dimension
· Above the line
· Always run right to left.

(dimension text will always run right to left on angled dimensions.)

Use Standard Arrows     This is the default. Dimensions will be started and ended with arrows pointing to 
reference lines that are drawn perpendicular to the dimension line.    (<----      ---->)

Use Abscissa Ends     Dimensions will be drawn with "Abscissa" lines drawn at 45° to reference lines 
that are drawn perpendicular to the dimension line. ( /----        ----/)
Note:        You can change this setting on existing dimensions by selecting the dimension and clicking 
Properties.

Dimension Line Style
· Use Line Style as Drawn (the dimension will use the line style current when drawn)
· Always use solid lines    (forces the use of solid lines)
· Never use thick dimension lines    (overrides the dimension line style if it is thicker than one pixel)



Preferences Snap Grid
Specify how you want the Snap Grid to act and appear.

Snap Action: Turn the snap action on.
Snap Visible: Make the grid visible. (This can be done independent from the above)
Snap Grid Spacing Change the grid spacing for the current zoom level.
Grid Lines    Specify a dotted or solid line, and the color to use.



Preferences Walls
Specify many parameters that determine how your walls will appear.

An illustration of the current wall settings appears at the top of the screen to show the results of your 
settings.

Width    Specify the the width of the wall

Color      Specify the color of the wall lines.

Wall Fill specify how the walls will be filled. They can be solid, have framing, of use hash marks.

Color      Specify the color of the wall filled area.

Framing If the walls use framing, you can specify how far apart the framing members are, and how thick.

Center Line You can have a center line drawn down the middle of the wall. It can be used for 
measuring purposes and for easier insertion of windows into the wall. Select to draw it always, just on the 
screen, or not at all (none at all is the default).

 



Preferences Directories

Select default directories (folders) both for loading and for saving plans.

· If "Use Last-used Folder" is checked, then the last-used folder is then used when Opening a plan, or 
using Save As.

· If "Always Use Default Folders" is checked, then the folders selected here will be used. 



Preferences Printing

Print Line Boldness  You can specify the printed line thickness, as printers differ in the way they output 
lines.

Text Size Factor Scaling text strictly according to the plan scale doesn't always provide acceptable 
results. You may want to change these settings to suit your preferences when you print at different scales.
Related item:    Scale Text to Drawing Size on the Preferences Drawing tab.

Omit Printed Dimensions when there isn't room for the dimension text: This checkbox is checked by
default.

Printing dimensions when the dimension is too small to provide room can make drawings look messy.
Printer resolutions and printing scales make it a complex task to assure clean looking drawings.

If you check this box, it becomes your responsibility to assure that your dimensions won't become too 
small to print properly at the chosen scale.

Limit the size of printed text

Set a maximum and a minimum for printed text.
Scaling from the screen to paper can cause text to be too large, or too small. These limits can help 
contain theat problem.



Number Pad

Use the Number pad keys to move the cursor a calibrated distance.
Note: the Numberpad setting on the Startup tab of the Preferences screen must be on for this to work.

Use the Plus and Minus keys to change this distance. The distance the cursor will move is displayed at 
the lower right, labeled "Speed".

Note: Many notebook computers don't have a separate numberpad. You can emulate this action by 
holding down the Shift key while using the non-numberpad arrow keys.

Without pressing the Shift key, the non-Numberpad arrow keys always move the cursor one pixel at a 
time.



Tools



Calculate Area
You can outline multiple areas and calculate the square areas in square feet or square meters.

· Click on the Tools/Calculate Area menu item

· Left click on as many points as necessary to outline an area to calculate.

· When done, Click again in the same place.

The area is filed with a hash fill, and the area and the current total area are shown.
Continue with another area, or click the Right mouse button when done.

The current total area is saved. You can enter it in your plan at any time from the Insert Text    dialog. 
(There is a button for the Last Area Calculation, that is enabled only when this number is greater than 
zero)

If a current area calculation exists when you start the routine, you are asked if you want to add to it, or 
start over.

NOTE: To display the latest area calculation on your plan
· Click the Text button on the Left Toolbar
· Click the "Last Area Calculation" button on the Text screen
· Edit the text if applicable
· Click the OK    button
· Position the text in your plan.

The "Last Area Calculation" button is only active if there is a total in memory.



Calculate Linear Distances
You can move the cursor over several distances, clicking on each change of direction to calculate the 
total distance.

· After clicking on the Tools/Calculate Linear Distances menu item, click the Left mouse button on as 
many points as necessary.

· When done, Click again in the same place.

The total distance covered is shown.



View / Alter
View / Alter is a handy tool to allow you to essentially recreate your plan one element at a time, and delete
or alter any of the drawing elements.

A View / Alter tool bar appears. You can drag it out of the way with the mouse.

· Use the on-screen buttons or their keyboard equivalent, to step through the plan.

· Use the Home key to go to the beginning of the plan.
· Use the Plus key to recreate each drawing element, the number of the element, and the type (line, 

rectangle, etc) is shown at the bottom of the tool bar, and the element itself is highlighted.

· Use the Alter Plan Toolbar buttons to modify the highlighted element.

· Use Esc to quit.



View Usage Log
You can view the Usage Log, and see the time spent on each plan.

Click on the Tools/View Usage Log menu item.

Then click on the name of the plan for which you want to
view the time stats.



Automatic Program Updates Digital River updates
You can automatically check for updates, download and install them from within the program.

· Click on the Updates/Update Program menu item
· Click on Logon and Check Version button

After connecting to the web site, you will get a notice of the latest version and whether an update is 
indicated.

If you elect to update, the latest version will be downloaded and installed.

Note: The program will terminate, and restart using the latest version. If automatic restart doesn't happen,
start Home Plan Pro manually.



Line Length

Line length is shown in the Status Bar.

While the Odometers show the horizontal and vertical distances, Line Length shows the total length of a 
line, regardless of the Line Angle.



Zorder
Zorder is a rather esoteric term that simply refers to the order that drawing elements exist in the plan.

Elements are drawn in the order they exist in the plan. An element may obscure an earlier element, and 
that may not be what you want.

To change the Zorder of an element, use the Stack item on the main menu, or select one element and 
use the Properties button on the Alter Plan tool bar.
You can move a selected element back and forward one element at a time, or all the way to the front or 
back.

Selected groups are all moved one element from their original position, unless you chose to move them 
all the way to the front or back. Then they are all placed together.
Ctrl F moves selected elements to the front.
Ctrl B moves selected elements to the back.
Holding the Shift key down moves just one position at a time.

Hint:  try drawing a few overlapping filled polygons and experiment with the Stack menu to illustrate the 
meaning of Zorder.



    Registration          Amazon.com Purchasers Click Here

Home Plan Pro
 
This is a fully functional shareware copy of    Home Plan Pro. You are encouraged to use all of its features
it to see if it suits your needs. If you continue to use the program after the evaluation period, you must 
register the software.

Select Help/Register. The registration information screen also appears when Home Plan Pro is started. 
The registration fee for Home Plan Pro is US$ 39.00.

Shareware copies can be converted to registered copies by entering a Registration Code. Home Plan 
Software provides such a Registration Code electronically or by mail upon payment of the registration fee.
No shipping charge applies unless a copy of the program is mailed.

A registered copy can also be purchased directly from:
Home Plan Software
8437    Center Street
Mokelumne Hill, CA    95245
http://www.homeplanpro.com/order.html
Orders: 800 903 4152    
Fax orders: 724 850 8187    
Ask for product # 171598 

Email: homepro@homeplanpro.com
Web Site: http://www.homeplanpro.com
Tech support: support@homplanpro.com

or: 209 286 1021

The registration fee for Home Plan Pro: US$ 39.00

Payment (in most major currencies) can be made by:
Visa
Mastercard
American Express
Check on US bank
Postal money order
Bank transfer



Home Plan Software
8437 W Center Street
Mokelumne Hill, CA    95245
Voice: 209 286-1021
Fax: 209 286 1319
Email: homepro@homeplanpro.com
Web Site: http://www.homeplanpro.com
Orders only: 800 903 4152
http://www.homeplanpro.com/order.html    
Ask for product # 171598 

Shareware is "try before you buy" software. The original, unregistered copy of this program may be 
copied and distributed freely; in fact we encourage you to share it!
    
However, every registered or installed copy of Home Plan Pro and its files are protected by copyright laws
and may not be distributed or used on more than one computer at the same time. 

Our other products include:
· Easy Mail
· Easy Mail Plus
· The HTML Editor

· Visit: http://www.homeplansoftware.com/freeware.htm    to download free software.

·
·  Home Plan Software has been an Author Member of the Association of Shareware Professionals
("ASP") since 1992. One of the main goals of the ASP is to preserve and enhance the quality of 
shareware. You can feel confident in the quality of software from an Author Member of the ASP.

· Home Plan Pro is copyrighted shareware. You have a free evaluation period of 30 days. If you 
continue to use Home Plan Pro beyond the 30 days evaluation period, you are expected to buy this 
software by paying a small registration fee. The software is not free.

· All copies of Home Plan Pro are fully functional.    When you pay the registration fee, you will 
receive a Registration Key. When you enter this Registration Key    all the registration reminder screens 
will permanently go away, and your copy will be registered.

N O T E:
· This program is produced by a member of the Association of Shareware Professionals (ASP). 
ASP wants to make sure that the shareware principle works for you. 

· If you are unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help. 

· The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does 
not provide technical support for members' products. Please write to the ASP Ombudsman at 157-F Love 
Ave, Greenwood, IN 46142, USA, FAX 317-888-2195, or send email to omb@asp-shareware.org



Keyboard access
See also:    Access Tools From The Keyboard

You can use the keyboard to draw with great precision.
You can use the mouse and the keyboard together to get the best of both methods.

· The Arrow Keys always move the cursor one pixel at a time. Great for precision, but slow.
· The Number Pad keys move the cursor faster.

You can always press F1 for help.
Here is a list of keyboard shortcuts: 

Customizing Tool Shortcut Keys

Default Tool Shortcut Keys

Zooming Shortcuts

Navigation Shortcuts

Visibility Toggle Keys

File Operations

Alter Plan Shortcuts

Drawing:

· ) or ( Draw Arcs 

· / or \ Draw Doors 

· C Draw circle or ellipse 

· D Draw Dimensions 

· L Draw a line 

· R Draw Rectangles 

· W Draw Walls 

· G Draw Windows 

· T Insert Text 

· H Hide rectangular area of plan 

· = Clone last element 

· E Activate Select Element tool 

· F Insert Predrawn Figures 

· U Undo last action (press Shift for Redo) 



· M Activate Select Group tool 

· . The period key connects to an adjacent line 

· Ctrl A Select All Visible Drawing Elements 

Zooming

· Z + Zoom in 

· Z - Zoom out 

· Shift + Alternate way to zoom in 

· Shift - Alternate way to zoom out 

· Ctrl Q Toggles zoom bar buttons visibility 
Navigation

To scroll the plan: 

· Hold down the Ctrl key and press an Arrow key to shift the plan slightly 

· Press Page UP to shift the plan a full page up 

· Press Page DN to shift the plan a full page down 

· Use the Shift key with the above to shift horizontal 

· Press HOME to go to the upper left corner 

· Press END to go to the bottom right corner 

· Press a number pad key to move the cursor the Speed setting 

· - Reduce "Speed" that cursor moves with the number pad keys 

· + Increase "Speed" that cursor moves with the number pad keys 
Visibility Toggles

· F5 Toggle Full Screen Cross Hairs 

· F7 Toggle among Measurement formats 

· F8 Toggle Snap Grid 

· Ctrl F8 Toggle Snap grid visibility 

· F9 Toggle between Metric and US dimensions 

· F3 Look for other selectable elements 

· Ctrl Q Toggles Zoom bar button visibility 

· Ctrl Tab Switches among loaded plans



File Operations

· P Print the plan 

· S Save plan 

· V View / Alter the plan 

Alter Plan Keyboard Shortcuts:

· Ctrl Del Delete Selected Element 

· Ctrl M Move Selected Element 

· Ctrl R Rotate Selected Element 

· Ctrl Z Resize Selected Element 

· Ctrl H Flip Element Horizontally 

· Ctrl V Flip Element Vertically 

· Ctrl C Change Color of Selected Element 

· Ctrl W Change settings of Selected Wall 

· Ctrl F Move selected element to the front (Shift to move one position) 

· Ctrl B Move selected element to the back (Shift to move one position) 

· Ctrl T Change settings of Selected Text 

· Ctrl I Expand Figure into separate Elements 

· Ctrl P Show Properties Screen for selected drawing element



Customize Tool Key Shortcuts

Available from the Options Menu

You can choose keys to use for the drawing tools



Odometer

As you draw, the distance of the cursor movement is displayed at the lower left of the screen.
The format is controlled by the Metric/US setting, and the Dimension style preference settings.

· Horiz is the horizontal distance the cursor has moved since the line was started.
· Vert is the vertical distance the cursor has moved since the line was started.
· Length    is the actual length of the line. 
· Angle is the angle of the line in degrees from start to end.

Length will differ from the "Horiz" or "Vert" if the line is drawn at an angle other than horizontal or vertical.

Line Angles are measured using    a 360° circle with 0° at the three o'clock position.
the degrees increase in a counterclockwise direction, so 90° degrees is on the top of the circle. 180°    at 
the left, and 270° at the bottom.

See also Reset Odometers



Custom paper sizes
You can specify a paper size to use, if it is not on your printer paper size list.

Click the Custom menu item, and enter the width and height of the paper you want to use.

Note: all printer drivers do not support user-defined paper sizes. Of course, you must be able to feed the 
paper into your printer in order to print on it.

This item is particularly useful for wide carriage printers. You can set the standard paper width (usually 
14"), and then set the length to 22" or 33", to print on two or three successive 14" x 11" sheets.



Alter Walls

After selecting a wall, you can change the fill pattern, color, thickness, and framing settings.



Alter Plan Toolbar

After Selecting elements, the Alter Plan toolbar is activated providing a selection of operations that can be
applied to the selected elements.



Expand Figure

Predrawn Figures are handled as one drawing element. You can move, rotate, resize them as a unit.

If you want to edit or alter a figure, it will be necessary to expand it into it's several drawing elements.
Once expanded, you can edit each drawing element, just as you can edit any element in the plan.

There is no provision to put the figure back together again. A future version will allow editing and saving of
predrawn figures.

Hint: To save commonly used user-drawn objects use the Save to Clip item on the File Menu.



Editing    the Plan

You can cut or copy drawing elements to a buffer for pasting into the current plan, or another plan.

After Selecting one or more drawing elements:
· Cut the selected element to place it in the buffer, and remove it from the plan.
· Copy it to place it in the buffer, and still keep it in the plan

When you have placed elements in the buffer, you are ready to paste them.
When you place elements in the buffer, they stay there until you replace them with new elements.

It works like the Windows Clipboard, but is local to the program.

Note: These edit buttons are "grayed out" unless there is something for them to do.
The Cut and Copy buttons are enabled only when there are elements selected.
The Paste button is enabled only when there are elements in the buffer.

See Also: Deleting Hidden Drawing Elements



Getting Started

It might be useful for you to load a few sample plans to get an idea of the kind of things Home Plan Pro 
can do, but the best way to learn Home Plan Pro, is to start a new plan and start drawing.

Start by drawing a line with the mouse:
1.    Press and Hold down the Left mouse button.
2.    Drag the line to where you want it to end.
3.    Release the button.
If the full screen crosshairs are on, you may need to move the cursor to see the line you just made.
Now repeat the above steps pressing the Shift key to draw an angled line.

Now to use the keyboard:
1.    Press the Enter key.
2.    Move the cursor with the cursor or number pad keys.
3.    Press the Enter key.

Got lines down? Click the mouse on the Dimension button.    
1.    Press the Left mouse button.
2.    Drag the line to where you want it to end.
3.    Release the Left mouse button.
Press Esc or click another tool to stop drawing dimensions. 

Try rectangles, walls, text, etc.
Keep drawing, you are well on your way to effectively using Home Plan Pro.

Note: Use Right Mouse button on a blank spot of the drawing to pop up a menu. 



PrintScale

When the word PrintScale appears on your plan, the actual scale of the printout will appear in its place 
on each printout.

Use the Insert Text routine to select PrintScale from the pre-defined text list.



Using the Right Mouse button
Previous versions of Home Plan Pro used the Right mouse button in a way that is unconventional 
compared to the normal Windows conventions.

For many years, Home Plan Pro had used the Right mouse button to:
1. Draw angled lines
2. Rotate predrawn figures
3. Terminate drawing multi-cornered polygons, etc.
4. As a sort of substitute Escape Key to stop using the current tool.

Folks got in the habit of drawing with the left button, and clicking the right button when done. Then along 
came Windows with a better way to use the right mouse button.

If you wish to use Home Plan Pro in the old mode, set the Right Mouse Button Usage to "Traditional 
HPP Usage" on the Preferences Configure tab.

The default is "Conventional Windows Usage" where a popup menu will appear on right clicks.

Under Conventional Windows Usage you can:
· Select single drawing elements just by right clicking them. 
· Click a blank spot on the drawing for a popup menu        
· Click the right mouse button on any tool button to see illustrated help on using that tool.

Note: The "Traditional HPP Usage" should really be called the "Archaic HPP Usage" and is not 
recommended.



Black and White
Available from the Options menu

The drawing elements in your plans use the assigned colors for lines, text, and fill patterns.
You can elect to display and print these colors, or not as you choose. 

Your plan will remember all the colors and display them again when you select Full Color from the Option
menu.

Note: It's easy to forget what colors are being used when you are drawing in Black and White mode. 
A better strategy would be to draw in full color and switch to Black and White when printing.

Note: Black and White means just that. There are only two colors used.
Many black and white printers can represent colors using gray scales. Printing in Full Color mode may 
provide a better looking printout than Black and White in this case. 



Printing Margins
Home Plan Pro uses a default 0.5 inch paper margin.
You can change the margins to any value, and the plan will be centered within the margins you set. Watch
the preview of the plan (or the dotted rectangle) move on the paper representation as you change the 
margins.
You can make room for a letterhead, or to place the plan on a pre-printed form.

Use the spin boxes above to change the paper margins.

Note: Increasing the paper margins will probably reduce the maximum print scale.
Decreasing the paper margin too far will place part of the plan in the printer's unprintable margin 

area, and truncate part of the plan.
Use the Printer Screen File/Printer Detailed Information menu item to obtain information on your 
printer's unprintable margins, and much more.



Undo / Redo

The Undo button is on the left. 
Each time you click this button, the most recent drawing element is removed.

The Redo button is on the right.
Each time you click this button, the most recently undone drawing element is restored.

There is no limit. You can remove the entire drawing one element at a time, and then restore it in reverse 
order.

 



Preferences Doors

Display Door Dimensions Determines whether the width of the door opening is shown, and allows 
selection of the font size used.

Door Dimension Font Height Set the height of door dimensions in pixels. The default is 10 pixels

Door Line Style You can set doors to always use a solid thin line, or to use whatever line style is 
current when the door is saved.

Door Opening Angle Set this to 90°    to always use this setting. Otherwise, the door opening angle will 
be determined by the final click before the door is saved.
Holding down the Control key temporarily reverses this setting.



Snap Grid
You can use a grid to force the cursor to stop in regular increments.

Most drawing probably doesn't lend itself to restricting cursor movement, but there are times when 
drawing in modules such as    two feet or 100mm is desired.

This is when the snap grid comes in handy.

From the View menu, you can
· Turn the grid on.
· show or hide visible lines showing the grid.
· Adjust the spacing between grid points.
Or you can click the snap labels in the Status Bar.

(a Snap Grid spacing is saved for each zoom level)

You will use the Snap Grid Settings form    to adjust the grid spacing.

See Preferences Snap Grid for other options.

Press the Control key to overide the Snap Grid action.



Faxing Your Plan
If you have a fax modem, you can fax your plans using the Windows Fax system or the Home Plan Pro 
built-in fax driver.
Some Windows installations have the Fax driver available, but not installed.    See here how to install the 
Windows fax driver.

Note:    Windows Vista "Home" version Does not provide fax support.    We are unable to provide fax 
support to Windows Vista "Home" installations.

If your Windows system has fax support, Home Plan pro will use the Windows fax system. If not, Home 
Plan pro will attempt to install its built-in fax driver.

To fax:.    From the File Menu, select Fax Current Plan or Fax Current Selection.
If there is any ambiguity about installed fax drivers, Home Plan pro will attempt to resolve that question.    
You may be asked to view multiple fax drivers and to chgoose one, or to wait while Home Plan Pro 
attempts to install the built-in fax driver.

Faxing is quite similar to printing, with the additional step of providing a recipient name and fax number. 
(Only the fax number is required, name and company are optional)
Enter the phone number with or without a "1" or area code, exactly as you would to make any other call.

Use the Preview Fax button to view the fax before sending it.

Faxes are limited to letter size or A4 paper, and black and white.
You can change the paper orientation, scale, margins in the same manner as is done in the Printing 
screen.



Install Windows fax driver
See also Faxing Your Plan

If your Windows installation has not installed the fax driver, Here's how to pull it out of its hiding place.

· Choose Control Panel from the Start menu. 
· Choose Add or Remove Programs. 
· Click Add/Remove Windows Components to start the Windows Components Wizard. 
· In the Components list, click to select the Fax Services check box, and then click Next. 

Windows begins to install the Fax program. If requested, insert your Microsoft Windows XP CD and click 
OK.

(No Microsoft Windows CD? Before assuming you're completely out of luck, tell Windows to look in this 
folder, instead: C:\windows\i386\, as some manufacturers hide it in there.)

Click Finish when installation is through. 



Zooming    
See also: Zoom Box Navigation Move to upper Left Screen Resolution Click to 
Zoom Make Plan Fit Screen Scale in CAD Zoom Bar Buttons

    Located in the Status Bar, the screen resolution tells you the real-world distance per screen pixel at the 
current zoom level. 
Click each of the buttons above to see what they do.
==================
Zooming is what enables you to see the entire plan at a small size, or a portion of the plan at a larger 
size.

How it works
Zooming is accomplished by assigning a distance to each screen pixel.
If we assign one inch to each pixel, a line will be four inches long after moving four pixels.
If we assign 1/4 inch to each pixel, the line will be only one inch long.

You can see that if we assign an awkward distance like 3/5 inch to each pixel, you would never be able to 
draw anything in even inches.

Limiting Zoom Sizes
Home Plan Pro provides several pre-set zoom levels that use common distances per pixel.
The "Screen Resolution" label above shows the real-world distance assigned to each pixel.

Be Aware
Be aware that drawing elements may have to be moved to an approximate screen location when they are 
zoomed to a size that isn't able to depict the exact location saved in the plan file. They will always print in 
the proper location.

For instance, a wall drawn at    3 3/4 inches thick cannot be displayed exactly if the zoom size supports 1 
inch per pixel. 
The wall still knows it is    3 3/4 inches thick, it will display    3 3/4 inches thick whenever possible, and will 
always print    3 3/4 inches thick.

Read the Rulers

 Become familiar with the numbers on the rulers to help identify zoom sizes.



Open Plan
Available from the File menu and the Toolbar

· Select a plan from the open file dialog.

· As the existing plan is loaded, the plan is sized to fit the screen. Use the zoom bar to select the 
magnification.

· Home Plan Pro is able to load multiple plans at once. The Window menu lists all the loaded plans, and 
you can switch among them.

· If you load a plan that is already loaded, you will be asked if you want to switch to the loaded plan, or if 
you want to replace the loaded plan with the version on disk.

See also: Zooming



Navigation Box
You can use the Navigation Box to navigate through your plan, or the Viewport Navigator.
Make the selection at the Preferences Navigation tab.

See Also: Zooming

Click on one of the sixteen squares to navigate to the area of the plan represented by the area clicked.



New Plan
Available from the File menu or the top Toolbar

· When you start a new plan, it opens a blank drawing screen at a default zoom level.

· If you have elected to use the Plan Size Dialog (See Preferences General), you can chose from a 
selection of plan sizes.

· Select a different zoom level, if desired, and start drawing.

See also: Zooming



Deleting Hidden Drawing Elements
If the plan contains drawing elements that have been hidden with the Hide tool, those elements can be 
deleted.

The Hide tool covers areas of your plan with a rectangle of the background color.

Drawing elements that are entirely hidden, can be deleted to make the plan smaller and to speed redraw 
time.

From the Edit Menu:
· Click Delete Hidden Drawing Elements
· Answer Yes to the prompt to delete any elements found.

Note:  Only elements that are completely hidden will be deleted.

See also: Delete Empty Hide Elements



Delete Empty Hide Elements
If the plan contains Hide elements that do not hide anything, you can delete them.

From the Edit menu:
· Click on "Delete Empty Hide Elements"
· Answer Yes when prompted to delete any empty Hide elements found.

Note:    Only Hide elements that don't cover up any part of a drawing element will be deleted.
See Also:    Deleting Hidden Drawing Elements



Reserved Words
When certain words are inserted into your plan, Home Plan Pro will substitute an appropriate value when 
the plan is printed.

Some reserved words are available from the Text form list and pre-set buttons. You can also type 
reserved words directly.

Reserved words are:

BYLINE = File name of current plan 
LASTSAVED = File date of current plan
CURRENTDATE = Todays date
CURRENTTIME = Current time
PRINTDATE = Date of printout
PRINTTIME = Time of printout
PRINTSCALE = Scale of printout
BYLINE = Plan by: < registered name>
FILENAME = File name of current plan
LASTSAVED = File date of current plan
CURRENTDATE = Todays date
CURRENTTIME = Current time
PRINTDATE = Date of printout
PRINTTIME = Time of printout
PRINTSCALE = Scale of printout

Note:    Reserved words are evaluated as appropriate. PrintTime for instance, is evaluated when you 
print. CurrentTime is evaluated on each redraw.

The Preset buttons for Time and Date enter fixed values. They are current when inserted, and do not 
change.
Typing CurrentTime (or selecting it from the list) inserts a dynamic time that changes each redraw.



Reset Odometers

After a drawing operation, the odometers retain their readings.

Press the tilde ( ~ ) key to set them to zero.
The odometers are reset automatically when you start to draw a new element, so is is not normally 
necessary to use this feature.

If you are in the midst of a drawing operation when you do this, the operation will be canceled in most 
cases.



drawing element

A drawing element is something you draw with the drawing tool bar buttons.
Lines, ellipses, rectangles, polygons, or lines of text are examples of drawing elements..



Line Angle

Line Angle is shown in the Status bar.

The angle of a line is measured from it's starting point. The angle progression is counter-clockwise as 
shown in the illustration.

Hold down the Shift key to draw at an angle other than horizontal or vertical.



Line attributes

See Also Choosing colors
Line attributes consist of:
· Line Thickness
· Line Style
· Line Color

· Use the Space bar to toggle among the supported line styles and thicknesses.
· (Alternatively, use the Line Style toolbar button)
· The current line style is displayed in theStatus bar.

· Use the Line button in the Status Bar.

· See also: Select Line Style



Esc
The escape key is used to:
· Cancel drawing elements
· Cancel the active drawing tool,

If a drawing element is in progress, press Esc to cancel it. The tool will remain active.
If no element is in progress, Press Esc to cancel the tool.

Note: it isn't necessary to cancel a drawing tool. You can simply select a different tool.



Access Tools from the Keyboard

· Press the Tab key to activate the Drawing tool bar.
· Use the arrow keys to scroll through the buttons. 
· Press Enter on a highlighted button to select the tool.

        See Shortcut Keys    for a list of keyboard shortcuts.
        See Customize Drawing Tool Shortcut Keys



Viewport Navigator
See also: Zooming

You can use the Viewport Navigator to navigate through your plan, or the Navigation Box Box. Make the 
selection at the Preferences Navigation tab.

The White area represents the drawing area.
The blue rectangle Represents the visible area of the plan.

To navigate:
1. Click the Left mouse button anywhere in the white area.
2. Drag the Blue rectangle to a new position.

Note: Depending on the size of the window you are using, and the screen resolution, you may, already 
be able to see the entire plan without scrolling.

To add or edit something to the top or left of the plan, Hold down the Shift key while clicking the left or top 
scrollbar buttons. The plan will scroll to the right or bottom.



Preferences Navigation
Specify how you want to navigate the drawing area.

Choose from the Zoom Box and Viewport Navigation toolbar components



Auto Draw
Input length, angle, and necessary specifications. The program will draw for you.



Line from Cursor Position
Available from Auto Draw Menu

· You are asked to click where you want the first line to start.
· You are asked to select the angle and length.

The line is drawn. 
You may draw multiple lines from this point. Click Cancel or escape to quit.



Connecting with Previous Elements

It isn't always easy to place the cursor exactly on a previously drawn drawing element.

If you can get the cursor within six pixels, you can press the Period (.) key to make the cursor snap to the 
exact point.

· Get the cursor close
· Press the period key
 
This routine will snap to the end or beginning of lines or rectangles, to the corners of rectangles and 
polygons, and to the center of an ellipse.



Preferences Windows

Draw Clear Window Background
Select this to erase an area under the window. The erased area is outlined.    This makes the windows 
stand out more clearly.

Select the window colors, patterns and thickness    that you want to be used to for your windows.



Layers - Overview
See also Preferences-Layers How to use Layers

Each new plan has a default layer called "Base Layer". "Base Layer" is active when you start a new plan. 
Each drawing element is assigned to the active layer when it is drawn. If you draw your entire plan without
adding additional layers, you don't need to be concerned about layers.

If you want to use the power of layers, here's how it works:
You can create new layers and make them active. When you draw new drawing elements, they will be 
assigned to these new layers. When those layers are made visible or invisible, so are all the drawing 
elements assigned to them.
 
This allows you to view and print only the parts of the plan that you want to see. For instance, you might 
hide the electrical and plumbing.

· Choose Add a Layer from Layers on the main menu.
· Enter a name for the new layer
· Be sure the new layer is checked as    Active
· Draw the things you want to be assigned to the new layer.

Checking / unchecking the visible box hides and shows all drawing elements assigned to that layer.

The Layer menu has items to facilitate using layers:

· Select drawing elements and move them to a different layer
· Change the name of the active layer
· Delete the active layer and all drawing elements in it
· Select all drawing elements in the active layer (maybe to copy them to a new plan)
· Make all layers visible or invisible

Note: If you create a new layer, and do not draw anything in it, the empty layer will not be saved.

Note: Layer names can be a maximum of ten characters in length. The Layer Name entry box will only 
allow ten characters. 

Note: As new Layer names are added, they are arranged in alphabetical order in the Layer Dialog. You 
can determine the order that your layers appear by the spelling of the names you assign to each layer.

Note: To edit any layer name, right click on it. 

Note: To make a layer active and make all other layers invisible, hold down the Control Key while 
clicking on the layer name,

Note: There should be a "layerDemo.pln" in the sample plans shipped with the program. View the Layer
Dialog with "layerDemo.pln" loaded to see some uses of layers.



 



Preferences Layers
See also: Layer Overview

Use Layers The default is to use layers. That doesn't mean that you have to use them, only that they 
are there if you want them. Uncheck this box if you want to disable layers altogether, and eliminate the 
Layer item from the Main Menu. 
You will be prompted to re-start    the program after you turn the Layer feature off. This will assure that the 
default settings are in effect.

Make new Layers active on creation.

· You can elect to make each new layer active as soon as it's created, so new drawing elements will be
assigned to the new layer.

· Or, you can elect not to do so.
· Or, you can elect to be asked each time.

Preserve layers on paste uncheck this if you want to assign all pasted drawing elements to the 
currently active layer. Check it to keep the original layer assignments (new layers will be made if they 
don't exist).



Element Properties
 Located on the Alter Plan Tool bar, the Element Properties button displays properties relevant to the 

selected drawing element. The button is inactive if more than one element has been selected.

This element is a line

· Change the Stack Order to move a drawing element in front of, or in back of other elements.
· Select a new layer to assign to the drawing element.
· Move the element by changing the distance to the top and left of the plan.
· Change the length of the element.
· Change the line style and color.
· Other properties will be displayed if they are relevant to the selected element.

Hint:    Right-clicking on a drawing element will select that element and produce a pop-up menu with 
items relevant to the type of element selected. You can select the Properties screen from that menu.



Epson 660,760,860 drivers

This refers to Epson Stylus printer drivers ending in "60". Specifically: 660; 760; and 860.

Note: Epson seems to have fixed their printer drivers.    If you are experiencing the following, contact 
Epson for a new driver.
__________________
This is an interesting puzzle. Epson 660, 760, and 860 printer drivers won't print with
any of our programs. The programs send the data to the Windows print manager. The Epson driver 
flashes the tray icon, but won't print. It isn't the printer. Load the Epson 640/740/840 driver, and it works 
fine.

Epson tells us to contact the printer manufacturer in Taiwan who made the driver. They don't reply. When 
customers call Epson support, they tell them to use the 640/740/840 drivers. 

There is simply no way we know of to control the printer driver after we
send the data to it. 

I'm sorry for the trouble, we're trying to get to the bottom of it. For now, you can load the Epson 
640/740/840 drivers and use that. The only drawback we've heard of in doing that, is that it doesn't 
monitor the ink level.
You can have both drivers loaded, pointing to the same port. Then you can switch between them by 
clicking in the Printers screen. 

I wish we had a better answer. We've never had a problem like this before. 

See also: Printing Problems



Printing Problems

Epson 660 / 760 / 860 problem

Printing Hints

Print to Scale

Select Black and White 

Printed Lines Hard to See

printout hard to see

Text Scaling

Detailed Print Preview

On-Screen Text

printed text

Printed Text Size Limits

Print Scale Information



Print to Scale
The print scale settings are at the lower left of the printing screen. 

The largest possible scale of the printout is determined by the actual size of the structure drawn and the 
size of the paper you are printing on. Only the scale options that will fit the drawing on the selected paper 
will be active. 

To get a larger scale for a given drawing, you need to use larger paper. If your printer doesn't support 
larger paper, you can print on regular paper and have it enlarged at a copy/print shop. If you put 
something on the drawing four feet long, you can ask them to blow it up until it is one inch long. That will 
provide 1/4" per ft scale. 

See also: Printing Hints Print Problems Print Margins Printout too small Print 
Scale Information Print on Fanfold Paper



Printing on Fanfold Paper



Print on Fanfold Paper

A hold-over from earlier days, tractor fed fanfold paper allows you to print across the perforations to get a 
larger printing area.
If you have a tractor feed printer you can do the following:

· Select a fanfold paper size.    (wide carriage printers allow 14" wide paper)
· Click "Print On Adjacent Fanfold Pages" on the Custom item of the Main Menu.

The print area will expand to cover two pages and print across the perforation.

See also: Printing Hints Print Problems Print Margins Printout too small Print 
Scale Information



How to use Layers

Every drawing element you draw belongs to a layer. Each new plan comes with a layer called "Base 
Layer"

When you draw something, it is assigned to the Active Layer

In the dialog above, the draftsman has created and assigned separate layers for:
· Electrical
· Plumbing
· Walls
It's like having four plans in one file. By checking or un-checking the visible boxes, you control what is 
displayed and printed.
When you load a plan, all the layers are visible. Use the Layer Dialog to switch layers to invisible as 
needed.

If you change your mind as to what layer a drawing element should be assigned (or if you want to retrofit 
an existing plan to use layers):
· Select a new Active Layer
· Select the element(s)
· Use "Move Selected Element to Active Layer" menu item.

· You can use the "Select All Elements in the Active Layer" menu item, and paste them into a new plan.
· You can rename any layer.
· You can delete an entire layer and all its elements.

Note: To make a layer active and make all other layers invisible, hold down the Control Key while 
clicking on the layer name,

Note: There should be a "layerDemo.pln" in the sample plans shipped with the program. View the Layer
Dialog with "layerDemo.pln" loaded to see some uses of layers.



Active Layer

Each new plan has one default layer called "Base Layer". Note the Active Layer is shown in red.
Everything you draw is assigned to the Active Layer.

Use the Layers menu to add and manage additional layers.
Once you have additional layers, you can make one of them the Active Layer.
Then everything you draw will be assigned to the new Active Layer.

NOTE: Any elements drawn on an invisible layer are not saved.

Note: To make a layer active and make all other layers invisible, hold down the Control Key while 
clicking on the layer name,



Walled Area from Cursor
Available from Auto Draw Menu

· You are asked to click where you want the first wall to start.
· Select the width and height of the rectangular area.
· Select to put the new walls in a New Plan, or insert them as a selection into the existing plan.

The walls are drawn. 

The current Wall Preferences are used.
See also Walls from Cursor Position.



Stairs
Available from the Auto-Draw menu
Use the Stair routine to generate views of stairs. 

The Stair Wizard will ask you to:
· Enter the overall height of the stairs 
· Enter the overall width of the stairs.
· Enter the tread depth
· Enter the    riser height, or use the "Calculate Optimum Riser Height" option.
· Select the direction of the stairway.

If you want a direction indicator on the plan, check the "Place a directional figure on the plan" checkbox.

Check the stair stats. Use the Back button to make changes.
When satisfied, Click the Finish button.

When you return to the plan, click the Left mouse button on the spot you want the lower left corner of the 
stairs to start.

After the stairs are drawn, you will be asked if you want to accept the results. If not, press the Cancel 
button.



Resize figures

A fast but not very precise way to resize a pre-drawn figure:
· Press the Plus or Minus keys while dragging the figure into place.
· The size of the figure will be changed in increments of about 10° each key press

To resize a figure more precisely:
· Click the right mouse button on the figure while it's still in the menu.
· When the Figure Resize form appears, enter new values in the width and height boxes.

To resize a figure that has already been placed in the drawing:
· Select the figure
· Use the Resize button on the Alter Plan toolbar

See Also:    Inserting a Figure Rotating Figures



Rotating Figure

After you have selected a pre-drawn figure, it is placed in the drawing area ready for you to drag it into 
place.

While dragging, and before you anchor it, click the right mouse button.
· The figure will rotate in 45° increments
· Hold down the Shift key to change the increments to 10°

To rotate a figure that has already been placed in the drawing:
· Select the figure
· Use the Rotate button on the Alter Plan toolbar

See Also: Inserting a Figure Resizing a Figure



Use of the Mouse
See also Mouse Scroll Wheel
How to use the Right Button:

· Click the right mouse button on a drawing element to select it and to see a popup menu of operations 
to perform on the element.

· Click the right mouse button on a blank spot of the drawing area to see a popup menu of drawing 
operations.

· Click the right mouse button on any tool button to see illustrated help on using that tool.

How to use the Left Button:

1. Start a drawing operation by clicking the left button on a drawing tool.
2. Click the left button on the drawing where you want the drawing element to start.
3. Move the cursor to where you want the drawing element to end and click the left button.

An alternative:
1. Start a drawing operation by clicking the left button on a drawing tool.
2. Click and hold the left button on the drawing where you want the drawing element to start.
3. Drag the cursor to where you want the where you want the drawing element to end.
4. Release the left mouse button.
(drawing tools vary, but most fit loosely into those two procedures)

Hint:
You can draw with the mouse and the keyboard together to get the best of both methods.

For instance: use the mouse to move the cursor most of the way, and an arrow key for the last few pixels.



Bitmap Pictures

See Also:      Vector and bitmap differences Picture Menu Picture Questions Manage 
Pictures

All serious CAD (Computer Assisted Drawing) programs store plans in a vector format.
This allows for accurate scaling and printing.

Home Plan Pro, relies on a vector format to store drawing elements.
In addition, you can also insert pictures into your plan.

Bitmap pictures are another group of image formats. 
Bitmaps have their own advantages: 
· They are capable of displaying realistic looking complex images. 
· Many bitmaps in Window's .BMP format are available
· Many bitmaps in .GIF and .JPG formats are readily available on the Internet
Because bitmaps cannot scale well, they are not normally used in CAD programs. 

Home Plan Pro can make use of bitmaps. You can insert bitmap pictures into your plans and move, 
resize, and rotate each one as a unit.

Because they are different, they cannot be selected and manipulated in exactly the same way as Home 
Plan Pro's native drawing elements.

· The bitmap pictures are located in files on your hard drive.

· The plan file doesn't store the bitmap picture. It stores the location of the bitmap's file.

· When your plan is loaded, Home Plan Pro looks for the picture's file and loads it into your plan.
If the picture can't be found, a message to that effect appears on your screen. 



Vector and bitmap differences
See Also: Bitmap Pictures Picture Menu How to use Bitmap Pictures Picture Questions

Bitmap pictures make great pictures. Anyone would have great difficulty 
reproducing the dog to the left using standard CAD drawing elements.

But, building structures are not dogs. Plans need to be moved, resized, rotated, and printed on many 
diverse printers.

Consider this vector line:

By moving the endpoints of a vector line, you can move, rotate, and scale without any distortion or loss of 
accuracy.

Now consider this bitmap line:

· Enlarging a Bitmap line only separates the dots that comprise the line, causing loss of clarity.
· Reducing a bitmap line causes some of the dots to be irretrievably lost. If you want to enlarge the line 

again, those dots are lost forever.

Home Plan Pro, like all serious CAD programs, relies on a vector format to store drawing elements.
In addition to this vector plan, you can also insert bitmaps into your plan. The bitmap pictures are located 
in files on your hard drive.

· The plan file doesn't store the bitmap picture. It stores the location of the bitmap file.

· When your plan is loaded, Home Plan Pro looks for the bitmap file and loads it into your plan.

· If the picture can't be found, a message to that effect appears on your screen.



Picture Menu
See also: Bitmap Pictures Vector and Bitmap Differences       
How to use Pictures Picture Questions    Manage Pictures



Insert Picture From File
See also: Bitmap Picture Vector and Bitmap Differences Picture Menu How to use Pictures

Picture Questions

Steps to loading a new picture
Prompts will ask you to:
· Browse for the picture's file. 
· Locate and click on the spot where you want the upper left of the picture
· Look at the "natural" picture size and optionally change the dimensions.

The picture will appear.



Picture Properties
See also:    Bitmap Pictures Vector and Bitmap Differences Picture Menu How to use Pictures

Available from the Manage Picture menu

Click this item to select a picture and view/edit its properties.



Fast Text

To type directly on the drawing using the font previously selected with Insert Text.

· Click the Fast Text button
· Click on the drawing where you want the text to start
· Type the text
· Press Enter.



Scalable patterns versus Filled polygons
See Also Scalable Pattern Form

Filled Polygons use Windows bitmap fills.
Filled Polygons:
Pros:
· Bitmap fills draw fast

Cons: 
· They do not scale when zoomed in or out.
· They do not scale to the printer resolution, often causing the area to appear solid, instead of the 

pattern you see on the screen.

Scalable patterns are drawn to scale on each redraw and printing.
Scalable Fills:
Pros:
· They scale When zoomed, so a "Brick" or "Shingle" is always sized in proportion to the rest of the 

drawing.
· They scale to the printer resolution, so the printout is always in scale.

Cons:
· Slow to draw. Redrawing takes longer.



Wall from Cursor Position
Available from Auto Draw Menu

· You are asked to click where you want the first wall to start.
· You are asked to select the angle and length.

The wall is drawn. 
You may draw multiple walls from this point. Click Cancel or escape to quit.

The current Wall Preferences are used.
See also Rectangular Walled Area.



Dimension From Cursor Position
Available from Auto Draw Menu

· You are asked to click where you want the first Dimension to start.
· You are asked to select the angle and length.

The dimension is drawn. 
You may draw multiple dimensions from this point. Click Cancel or escape to quit.

The current Dimension Preferences are used.



Rectangle From Cursor Position
Available from Auto Draw Menu

· Click where you want the upper left corner of the rectangle
· Select the width and height of the rectangle.
· Click the Draw button



Contiguous Lines
Available from Auto Draw Menu
Generate lines, each connected to the end of the previous.

· You are asked to click where you want the first Line to start.
· You are asked to select the angle and length.

The Line is drawn. 
You may draw multiple lines from the end of the last line. Click Cancel or escape to quit.



Rectangular Walled Area
Available from Auto Draw Menu

· Select the width and height of the rectangular area.
· Select to put the new walls in a New Plan, or insert them as a selection into the existing plan.

The walls are drawn. 

The current Wall Preferences are used.
See also Walls from Cursor Position.



Redrawing
Redrawing the plan involves erasing the plan and drawing it from the beginning.

The plan is redrawn often during the course of working on a plan.
You can force a redraw from the Toolbar button, or the View menu.

Often drawing artifacts are left over from drawing operations. They are not saved as part of the plan, but 
may temporarily clutter the screen.
Clicking on the Options Menu Redraw item will clear the unwanted artifacts.

Redrawing is usually rather fast. The exception are Scalable Patterns. If redrawing becomes intolerably 
slow, you might want to delete the scalable patterns until you are through with the rest of the plan.



Select Black and White to save colored ink.
If you use a color printer, you know how fast those color cartridges run out of ink.

Fix:
To save on colored ink, use the Options/Black and White setting until the final printout.



Move Pictures
See also:    Bitmap Pictures Vector and Bitmap Differences Picture Menu How to use Picture
Available from the Manage Picture menu

You can move a picture to a new location in the plan.
· Select a picture from the Picture list, or Right-click near the edge of the picture.
· A highlighted box is drawn around the picture.
· Drag the picture to a new location, and press the Left button to see the picture drawn in the new 

location.
· Repeat until the position is correct. Then click the left button again (or Escape) to quit.



Rotate Pictures
See also:    Bitmap Pictures Vector and Bitmap Differences Picture Menu How to use Pictures

Picture Questions
Available from the Manage Image menu

You can rotate a picture

· Select the image to be rotated from the Picture list.
· Rotate the picture using the buttons on the form or use the    "Spin Box"
The image will be rotated on the plan.

Note: Pictures are rectangular in shape. Pictures that are displayed in other than 90º increments have 
to "grow" in size to accommodate the angle. This may cause lots of white space on the edges and 
corners of the rotated image.

Consequently, any resizing information is no longer applicable. a re-sized image must be re-sized again 
after rotating.



Resize Pictures
See also:    Bitmap Pictures Vector and Bitmap Differences Picture Menu How to use Pictures
Available from the Manage Pictures menu

· Select a picture from the image list, or right-click near the edge of the picture to select it.

A box with "handles" appears around the picture.
When the cursor is over a handle, it turns into a double headed arrow, indicating the direction to drag.

· Drag the edge or corner to change the size.
· Drag a corner to keep the original aspect ratio.
· Double click on an empty area when done resizing

You can use Re-size Image by Dimension, to enter the new overall dimensions for the image.

Note: Pictures are stored in separate bitmap files. When you resize an image, the image is just 
"Stretched" to make it appear bigger or smaller.

Pictures are rectangular in shape. Rotating them has to change the size of the image in order to 
accommodate the angle. Consequently, the resizing information is no longer applicable. The image must 
be re-sized again after rotating.



Resize Pictures by Dimension
See also:    Bitmap Pictures Vector and Bitmap Differences Picture Menu How to use Pictures
Available from the Manage Pictures menu.

Use this item to resize an image by entering a new height and width instead of dragging with the mouse.

· Select the picture to resize from the picture list.
· Enter a width and height.

The image is resized.



Delete Pictures
See also:    Bitmap Images Vector and bitmap differences Image Menu How to use Bitmap 
Images
Available from the Manage Pictures menu.

· Select a picture from the list and delete it.



How to use Pictures
See Also: Bitmap Pictures Picture Menu Picture Questions Manage Pictures

See Vector and Bitmap Differences for the strengths and weaknesses of bitmap pictures.

When to insert bitmap pictures into your plans:

· When the picture is small, and scaling isn't a major factor.
· When you have a great picture that would be hard to draw.
· When you want to trace the picture, and then delete the picture.

When you shouldn't insert bitmap pictures:

· Large bitmaps aggravate scaling problems.
· Fixtures, symbols, and the like aren't of crucial importance if they distort a little.
· logos and title boxes are naturals.
· When you plan to share your plans with other computers.

Things to watch for:

· Your plan will store the image filename and path. If the file moves or is deleted, Home Plan Pro won't 
be able to find it.

· If you send a plan to a co-worker, they will need the file.
· If you send a plan to a co-worker, they will need to duplicate the same file path that exists on your 

machine.
    



Picture Questions & Answers
Vector and Bitmap              Differences  Picture Menu How to use Pictures Bitmap Pictures Insert 
Picture From File Manage Pictures

Q: What kind of pictures can I insert?

A: Image files with the following extensions are supported:
.jpg,    .jpeg,    .gif    .bmp    .ico    .wmf    .emf

Q: Why can't I edit a picture?

A: Home Plan Pro, like all CAD programs uses a vector format to store drawing elements.
Bitmap pictures can be inserted into plans, but they cannot be edited in Home Plan Pro.

Use a program like Window's Paint to edit the bitmaps prior to inserting them. Paint Shop Pro is a favorite
of many of our users(http://www.jasc.com/products/paintshoppro/).

 
Q: When I rotate an image that I had resized, it reverts to the "natural" size.

A: Pictures are rectangular in shape. Rotating them has to increase the size of the picture to 
accommodate the angle. This may cause lots of white space on the edges and corners of the rotated 
picture.

Consequently, the resizing information is no longer applicable. The picture must be re-sized again after 
rotating it.
 
Q: When I insert pictures, and print them, the resolution seems to degrade.

A: Bitmaps are not scalable. Your printer probably has a resolution much greater than the screen. 
scaling bitmaps almost always degrades image quality.

Q: Is there a way to avoid the scaling problem with bitmaps?

A: Some users insert pictures, trace over the picture with Home Plan Pro drawing elements, and 
then delete the picture.



Manage Pictures

See also: Bitmap Pictures Vector and Bitmap Differences       
How to use Picture Picture Questions

Click a button to see what that button does.



Preferences Pictures
See also: Bitmap Pictures How to use Pictures Picture Questions Vector and Bitmap 
Differences

Rotate and Resize Pictures when Inserting:
If this box is checked, you will be asked if you want to rotate the picture prior to inserting. Then, 

after moving the picture into place, you will be asked if you want to re-size the picture.
If this box is not checked, the picture will simply appear ready for you to move it into place.

Selecting Bitmap Files: 
You have two choices:
· Home Plan Pro can scan each folder and display any pictures for you to choose from
· You can use the Windows Picture dialog to select files by name and view them one at a time.
The default is to scan folders and display all pictures. It's probably easier to use the default option unless 
your machine has a shortage of imaging resources.

Bitmap Storage Method:
· Keep    bitmaps In Memory
· Access Bitmaps From Disk
The default is to keep bitmaps in memory. This makes drawing faster. Accessing from disk might be 
necessary if your machine is running out of imaging resources.



Email the Current Plan

Available from the File Menu See also: DNS and Host name information Authentication

If you have an internet connection, you can attach the current plan to an email message and send it. The 
recipient will need a copy of Home Plan Pro to be able to use the plan.
 

The plan file (on your hard drive) will be attached to the email message. 
You can add any other files using the "Attach New File" button.

· The first time, you will have to type your name and email address. (Home Plan Pro will remember 
them).

· Type the recipient's email in the Recipient Email box. (Home Plan Pro will remember the most recent 
addresses in the drop down list)

· Type a subject.
· Type a message

Click the "Send" button.

Tip: Advise the recipient to save the plan to their hard drive before loading it into Home Plan Pro.
Although the current plan is automatically added to the "Attach File" list, you can attach any other 

files (or none at all) to the email message. (change the "File Type" on the open file dialog to "All Files")
You might want to export a plan to a DXF file, or a bitmap and attach that to the message for folks

who don't have Home Plan Pro on their machine.

NOTICE: Note the Use Dynamic DNS and Use ISP Hostname choices.

Use Dynamic DNS uses a built-in email server so you don't have to enter your ISP information.    Some 
recipient's ISP's will reject email sent from such an email server as a anti-spam measure.    If you are 
unable to send emails to your recipients with this method, you will have to select The other method.

Use ISP Hostname This method uses your own internet service provider.    You will have to enter your 
provider's host name.    This is the hostname you enter in your email client. Examples are: 
smtp.comcast.com or mail.msn.com or smtp.aol.com

A few providers require authentication before you can send email.    Most do not.
If your provider requires authentication, check the "Use Email Authentication" checkbox and enter your 
username and password .



Draw a Bezier Curve
See also: Contiguous Bezier Curves

A bezier curve is a rather esoteric shape drawn by a seemingly mystical process. It can provide graceful 
and useful curves for contour lines, fish ponds, and countless other drafting uses.

· Click where you want the curve to start.

· Click on the other end of the curve. A default shape is drawn with two "Control Points"
The control points control the shape of the curve.

· Drag the control points with the left button to change the curve's shape.
You can also drag the end points.

· Double-click the left mouse button to terminate and anchor the curve.

Note: Use Contiguous Bezier Curves on the AutoDraw menu to chain multiple curves.



Contiguous Bezier Curves
Available from Auto Draw Menu
You can chain multiple bezier curves end-to-end.

Click Contiguous Bezier Curves on the AutoDraw menu.

After the first curve is terminated, you are asked if you want to start another curve.
Answer yes and a new curve is started with the initial point at the end of the last curve.

See Draw a bezier Curve for drawing instructions.



Amazon.com Purchasers

            

Home Plan Pro Registration
 
If you have purchased a license from Amazon.com, you will have a "Key" and a "Password".

Select Help/Register on the main menu. The registration information screen also appears when 
Home Plan Pro is started.

Click the button labeled "Amazon Users Click Here"
· Type the key into the "Amazon key" box.
· Type the password in the "Password" box.
· Click the Ok button

A registered copy can also be purchased directly from:
Home Plan Software
8437 W Center Street
Mokelumne Hill, CA    95245
Orders: 800 903 4152    
Fax orders: 724 850 8187    
Ask for product # 171598 (171593 w/ CD)

Email: homepro@homeplanpro.com
Web Site: http://www.homeplanpro.com
Tech support: support@homplanpro.com

or: 209 286 1021

The registration fee for Home Plan Pro: US$ 39.00

Payment (in most major currencies) can be made by:
Visa
Mastercard
American Express
Check on US bank
Postal money order
Bank transfer



Choosing colors
See Also:
Change Element Color
Line attributes
Edit Plan Colors
Available from the Status Bar Button.

· Pass the mouse over a color to see a sample in the top box.
· Click a color to select it

At the bottom of the form is a "Recently used" group of the last twelve colors you used.
These colors will be remembered and available each time you use the color dialog.



Edit Plan Colors
Available from the Edit Menu

The Edit Plan Colors form displays all colors used in the current plan.
The colors are divided into three sections. Click on a tab to see:
· Line colors
· Solid fill colors
· Text colors
----------------------------------------
· Click a color to select it.
· Use the "Replace Selected Color" button to replace all instances of this color with a new color.
· Edit the numbers in the Red; Green; Blue edit boxes to change all instances of the selected color.
· Click the "Revert to Initial Color" button to cancel changes to that particular color.
----------------------------------------
Click "OK" to apply the changes to your plan.
Click "Cancel" to exit without making any permanent changes.



Scaled Fill Rectangle
From the Scaled Fill Pattern form.

With the mouse:
· Click a corner of the rectangle.
· Click the opposite corner.

With the keyboard:
· Position the cursor at a corner of the rectangle.
· Press Enter and move the cursor with the arrow keys to the opposite corner.
· Press Enter.

 Continue drawing Scaled Fill rectangles or select another tool.



Scalable Fill Polygon
From the Scaled Fill Pattern form.

With the mouse:
· Click the point at which to begin.
· Click points as needed to draw additional sides.
· After clicking the last point, click again to close and complete the polygon.

With the keyboard:
· Position the cursor at the point at which to begin.
· Press Enter and move the cursor with the arrow keys to the end of the side.
· Repeat the above for each side.
· Press Enter to end drawing to the last point.
· Press Enter again to close and complete the polygon.

        Continue drawing Scaled Fill polygons or select another tool.



Select Scalable Pattern
From the Scaled Fill Pattern form.
 See also Scalable patterns versus Filled polygons

· Click a pattern from the list.
A sample of the selected pattern appears in the pattern window.

· Select from the dimensions available for the selected pattern
The pattern in the display reflects the dimension changes.

· Framing and Siding patterns can be switched between vertical and horizontal.
The pattern in the display reflects the change.

· Click the Rectangle button to draw a filled rectangle
· Click the Polygon button to draw a filled polygon
· Click Cancel to Quit.



What's New
Welcome to Version 5.2.
New in version 5.2

Version 5 is a major re-write of the graphic engine. Previous versions severely limited the ability to 
magnify areas of the plan, and to draw in fine detail. 

Now, you can draw plans as large as you like (6400 ft square - 900,000 mm in metric mode) and still 
Zoom in to    1/32 of an inch (1mm in metric mode).
It is no longer necessary to select a drawing size for your plans. Plans of any size can be zoomed in to 
draw in minute detail.

New Zoom Bar buttons provide instant zooming to any level and provide good feedback.

Scrollbars shift the plan at any zoom level, and a special button at the beginning of each scrollbar shifts 
the plan creating more drawing area at the left and top of the plan.

Buttons move the plan to the upper left, or fit the entire plan to the viewing area and help navigate the 
plan while zooming.

New Parallel Line routine draws continuous parallel lines, cleaning up the corners. You can adjust the 
distance between the lines.

New Parallel Line rectangle routine draws rectangles with double lines. You can adjust the distance 
between the lines.

Walls are no longer limited to full inches or to increments of 25mm.

You can have a center line drawn the length of walls for aid in positioning windows and doors.

Windows now have adjustable widths and patterns.

Snap Grid distances are saved separately for each zoom level.

Speed settings are also saved separately for each zoom level.

Metes & Bounds draw lot lines from the data in your deed description.

A Detailed Print Preview shows an image of the printout, and allows adjustment of text prior to printing.

A Text Size Limiting feature prevents printed text from scaling too big when small plans are printed.

Save your plans to a PDF file
____________________________________________

New in version 4.6:

More colors
The number of colors in the color selection box has increased from 16 to 224.
A row consisting of the twelve most recent colors chosen is maintained for your convenience.

Customize colors
From the Edit menu, you can manually change the red, green,blue (RGB) of any color currently used in 
the plan by typing in a new value for red, green, or blue.



Scalable Fills
Scalable fill patterns used to be limited to rectangular shapes. Now make polygons with up to 32 sides 
and fill them with scalable fills.

Increased polygon vertices
The maximum number of Polygon sides is increased from 16 to 32.

NOTE: The file format used to store your plans has changed to accommodate these new features.
When you load a plan that was made in a previous version, it will be automatically converted to the new 
format.
A backup of the old file format will be made with the same name and location, but with a ".bk" extension.

This conversion is not backwards compatible. That means that new or converted plans cannot be read in 
older versions of Home Plan Pro. To load a converted plan in an older version of Home Plan Pro, you will 
have to re-name the backup to have it's original ".pln" extension.



Rulers

Rulers measure across the top and left side of the drawing area. Rulers adjust automatically for the 
current drawing size.

· Toggle ruler visibility from the View menu
· Right click on a ruler to adjust the zero position.



Select Another Element

Sometimes, two or more drawing elements overlap each other. When this happens, the first element 
found at the cursor location will be selected when using the Select Element tool or clicking the right 
mouse button near the edge of an element.
(Pre-drawn figures select better from the center, bezier curves from their ends.) 

To select another element occupying the same location:
· Press the F3 key 
· Select "Search For Another Element at This Location" from the right-click popup menu.
 
The file will be searched further. 
If another drawing element shares that location, it will be selected instead of the currently selected 
element. 
When the plan has been searched to the end, it will start again at the beginning of the file.

If there is no other element sharing that location, the currently selected element will stay selected.

When all selected elements are of the same type, additional options are available.
For instance:
If all selected elements are walls, you can do things that pertain to walls, like changing the wall thickness 
or the fill pattern. All selected walls will reflect these changes.

If all the selected elements are text, you can change the font specifications for all the selected text 
elements.

But, if the selected elements are of different types - i.e. some are walls, some are text - then you are 
limited to operations that can be performed on any element like moving, copying, etc.



Manage Backups

Every time you save a plan file, Home Plan Pro will make a backup of the plan prior to saving it.
This means that your latest changes will not be backed up until you save the plan once again.
Why do we backup the previous version of your plan?

Uncheck the Make Backups Checkbox checkbox if you do not want this action to take place.



Make Backups Checkbox

If the "Make a Backup Prior to Saving" checkbox is checked,
then the plan will be backed up to this list each time you save the plan, prior to saving.

If you clear this box, your plans will not be backed up.



Select by Element Type
Accessed from the Edit menu
See also Select Element Tool Select Group 

To select all instances of a particular drawing element:

· Choose an element type and click the "Accept Selected Element" button.
· Or just Double click on an element type in the list.

Examples: 
Double click on "Text" to select all text so you can change all the fonts.
Double click on "Walls" so you can change the color or    fill patterns of all walls.

Note: Drawing elements that are in an invisible layer will not be selected.

If you want to remove an element from the selection:
· Click the Select Element tool button
· Hold the Shift key down and click on a selected element to de-select it.

If you want to keep the current selection and add to it:
· Click the Select Element tool button
· Hold the Shift key down when selecting other elements to add them to the selected list

When all selected elements are of the same type, additional options are available.
For instance:
If all selected elements are walls, you can do things that pertain to walls, like changing the wall thickness 
or the fill pattern. All selected walls will reflect these changes.

If all the selected elements are text, you can change the font specifications for all the selected text 
elements.

But, if the selected elements are of different types - i.e. some are walls, some are text - then you are 
limited to operations that can be performed on any element like moving, copying, etc.



Selecting with the Shift key
Applies to the Select Element tool

See also Select Another Element Select Group Select by Element Type

The Select Element tool allows you to select drawing elements by clicking near their edge.
(Pre-drawn figures select better from the center, bezier curves from their ends.)

Each time you select an element, any previously selected elements are de-selected.

If you want to keep the current selection and add to it:
· Hold the Shift key down when selecting other elements to add them to the selected list

If you want to remove an element from the selection:
· Hold the Shift key down and click on a selected element to de-select it.



Digital River updates

The Digital River file protection system precludes using our system of automatic updating.
The Update Menu does not appear on these copies of Home Plan Pro.

Customers who have already registered through Digital River, and want automatic update capability can 
switch to the regular version at no charge. 

Send us an email at: 
hpp@homeplanpro.com 
for the download url and registration information



Move routine changes
Ctrl M from the keyboard
See also:      Moving Selected Elements

Version 4.5.26 introduced changes in how Home Plan Pro moves selected drawing elements.
Note: You can toggle between the two Move methods at the Preferences Configure tab.

Prior versions simply locked the cursor to the selection after the Move routine was chosen.
It was not necessary to press the left mouse button, the selection just followed the cursor. Because the 
cursor was locked to the selection, you were not able to do anything else until you terminated the move.

Starting in version 4.5.26, the mouse is free to move over the plan and toolbars.
To move, you need to place the cursor over the selection. When the cursor turns into a "Move" cursor, you
can drag the selection by pressing the left mouse button and dragging the selection with either the mouse
or the keyboard, or both. 
Release the button to anchor the selection and to cause it to be drawn in the new location.

To end the moving process Do one of the following:
· Double click on a blank area of the drawing
· Press Escape
· Select another drawing tool.

Note: in version 4.5.26, and later, when the left mouse button is not depressed, you can move the 
cursor freely over the rest of the plan and access the toolbars and menus. Just go back to the selection to
drag it around.



Pasting From the Buffer

See also: Copy Elements to Buffer
You can paste drawing elements that have been cut or copied from one plan into the current plan, or a 
different plan.

The Paste button (it's grayed out in the picture above) comes alive when one or more drawing elements 
have been selected and copied.

· Click the Paste button to cause the saved elements to be placed into the plan, selected and ready to 
be moved into place.

· Place the cursor over the new selection and the cursor turns into a "Move" cursor (four headed 
arrow).

· Press the left mouse button and move the selection
· Release the mouse button to anchor the selection and cause it to be drawn in the new location.

Repeat the above until the position is correct. 

To end the moving process Do one of the following:
· Double click on a blank area of the drawing
· Press Escape
· Select another drawing tool.



Copy Elements to Buffer

See Also: Cut Elements to Buffer
You can copy drawing elements to the buffer to paste into the current plan or into a different plan.

Select an element or select a group of elements

· Click the Copy button to cause copies of the selected elements to be placed in the buffer waiting to be
pasted.



Cut Elements to Buffer

See Also: Copy Elements to Buffer
You can cut drawing elements to the buffer to paste into the current plan or into a different plan.

Select an element or select a group of elements

· Click the Cut button (the scissors above) to cause the selected elements to be removed from the plan
and placed in the buffer waiting to be pasted.



Preferences Configure

Scroll Plan With Mouse    Check this if you want the plan to scroll whenever the mouse is near the edge. 
Pressing the Control key will temporarily reverse this setting.
Many users prefer to leave this off and press the Control key when they want to scroll. Others like the 
convenience of automatic scroll. Try it and see which you prefer.

Confirm Deletions You can set Home Plan Pro to permanently and quietly delete elements, copy 
deleted elements to the buffer for re-use, or to ask you first (The last is the default).

Configure the Move Routine Select whether to:
· "Lock" the cursor to the selection so it always follows the cursor until you terminate the routine.
· Allow free cursor movement unless you depress the left mouse button and "drag" the selection.
See also Move Routine Changes

Configure Pasting Elements
· Start newly pasted elements in their original location
· Start Newly pasted elements in the center of the viewing area

Right Mouse Button Usage Default operation pops up a menu when the drawing area is Right 
clicked.
Select "Traditional HPP Usage" if you want the Right mouse button to cancel drawing operations, and 
generally work like previous non-Windows versions.



Print Manager
Toggle the Print Manager off and On from the Print Screen Options menu.

Home Plan Pro uses a manager to read your printer drivers and access them.
The Print Manager allows you to:

Select among your printers
Select a paper size
Select a paper source
Select the print resolution.

If it takes too long for the Print Screen to activate, or if there is some conflict with your printer driver, you 
can uncheck the "Use Printer Manager" item on the Printing Screen's File Menu.

Normal printer settings are available from the Print Dialog after you click the Print button.



Print Preview
Toggle Print Preview off and On from the Print Screen Options menu.
See also Insert Text Text Scaling Detailed Print Preview Printed Text Size Factor Printed 
Text Size Limits
A preview of the plan on the selected paper is shown prior to printing.
If the preview is slow appearing, you can turn it off from the Printer Screen's Options menu.

If the preview is turned off, the plan will appear as a dotted outline on the screen.



Speed

"Speed" is a term used for the distance that the cursor moves when the Number Pad keys are pressed.

Use the Speed Panel buttons or the Plus and Minus keys to change this distance.

Many users prefer to use the keyboard to move the cursor rather than the mouse. Others use the mouse 
and finish up with the keyboard.

The keyboard arrow keys always move one pixel at a time. The Number Pad keys move according to this 
setting.

For instance you might:
· Set the Speed to one foot.
· Press the "6" key on the number pad five times
· Press the right arrow keys six times to draw a line 5' 6" long

In Metric mode, you might:
· Set the Speed to 100mm.
· Press the "6" key on the number pad five times
· Press the right arrow keys six times to draw a line 506 mm long



Printout too small
A common report is that printouts don't "fill the paper". This condition is an indication that there is a 
drawing element somewhere beyond the area you consider to be the plan.
Commonly, it is an erasure, or a tiny dot that is hard to see, but that nevertheless, convinces Home Pro 
that it needs to be printed. 
The actual plan has to be made smaller In order to fit this unwanted drawing element on the paper.

Fix:
We need to get rid of the unwanted drawing element. 
1. Use the Group Selection tool to select only the main drawing
2. Paste that into a new plan. 
This should leave the unwanted drawing element behind and solve the problem.
____________________



Export
Available from the File Menu

See also Export to a DXF File
See also:    Save to PDF File

You can export your plans to other file formats.

· DXF is an Autocad public file format. Many CAD programs are able to read DXF files.
Note: Some Proprietary Home Plan Pro drawing elements are not able to be shown in DXF format.

· EMF is a vector graphic that scales better than bitmaps. It cannot be used in most web site browsers

· BMP, GIF, JPG are bitmap graphic file formats. Bitmap files can be inserted into word processing and 
fax files. JPG and GIF files can be viewed in web site browsers.

Note: Because of the nature of bitmap files, the resolution will be much poorer than Home Plan Pro's 
native PLN format. 

·     PDF file that can be read in Acrobat Reader
(Copyright © 2009 Adobe Systems Incorporated)



DNS and Host name information

Home Plan Pro can attach plans to email messages and send them to recipients of your choice.

The easiest way for us to do that, is to use the DNS (Domain Name System) of your machine. Each 
machine has a DNS assigned when they are connected to the internet. You don't even need a email 
server to use your machine's dynamic DNS.

A growing number of internet servers who are unwilling to accept email from dynamic DNS numbers. If 
your recipient gets their email from one of those servers, you will get a message to that effect.

If this is a problem for your recipients, you can check the "Use Host Name" radio button at the lower right 
of the Email screen.
When you do that, you will be asked to enter a host name. Your email provider can tell you what their host
name is. An example is: "mail.msn.com".

Home Plan Pro will remember the host name and use it as long as the "Use Host Name" radio button is 
selected.



Recently Used Figures

The Recently Used Figure tab on the Predrawn Figure menu stores the 24    figures you used last.

The figures you use most often are thus available without having to click through to each individual figure 
library.

After the Recently Used Figure menu is full, the oldest figure will scroll off to make room for the newest.
If you want to halt changes to the Recently Used Figure Menu, Check the "Lock Menu" checkbox.
No new figures will be added until you clear the checkbox.

To remove a figure from the Recently Used Figure menu, Right-click on the figure and select "Remove 
This Figure" from the popup menu.



Print Snapshot
See Also: Printing Your Plans

Print a snapshot of the plan as it currently appears on the screen.

This handy feature shows a preview, and allows you to fill the paper with the plan as it appears at that 
moment on the screen.

· Use it to print quickly when printing to scale isn't necessary.

The toolbar controls Set Margins, Print, Setup Printer, and adjust zoom in the Preview screen.

Note: for best resolution, and exact scaling, use the Print button on the main toolbar.



Printout lines hard to see
Printers with a very high resolution, may draw very thin lines. This is because that by default, each line is 
one pixel wide. If you want to print at much over 300 DPI, you should adjust the Print Line Boldness.

Fix:
Go to the Printing tab on the Preferences form and select a degree of Print Line Boldness.
It's best to select an odd number, so the line will be centered. i.e.. 3x or 5x will draw lines three or five 
pixels in width.



Entire printout hard to see
Some Printers have a problem printing colors. You can check the "Black and White" setting on the 
Options menu to see if that is the case with your printer.

Fix:
If it prints normally in black and white you should change the colors to black. The reason is that the 
"Black and White" setting, while useful for saving colored ink, doesn't provide gray scale printing. It's 
really just black and white! 

Select groups of elements and click the Color button on the Alter Plan tool bar. 



Contiguous Dimensions
Available from Auto Draw Menu
Generate Dimensions, each connected to the end of the previous.

· You are asked to click where you want the first Dimension to start.
· You are asked to select the angle and length.

The Dimension is drawn. 
You may draw multiple lines from the end of the last line. Click Cancel or escape to quit.



Export to a DXF File
Available from the File/Export submenu
See also Export

Many CAD programs can read DXF files. DXF is the public file format for AutoCad.

After you select a filename for the DXF file, you are shown an Options screen.
Start the export by clicking the Export to DXF File button after setting the following options as necessary:

DXF Version: You can choose to export in Autocad version 14 or version 2000

Export Hidden Text: If your plan has hidden text (See View Menu), it will not be exported unless 
you check this box.

Export Hidden Dimensions: If your plan has hidden dimensions (See View Menu), they will not 
be exported unless you check this box.
(the two items above will be "grayed out" if there is no hidden text or dimensions in the plan)

Export Entire Plan to One DXF Layer: Check this box if you want all layers exported to the 
same DXF layer.

Export Each Layer to a Corresponding DXF Layer: Each drawing element in the DXF file will 
have the same layer assignment and layer name as it had in Home Plan Pro. This option takes a little 
longer to export.
(the two items above will be "grayed out" if there is only one layer in the plan)

Export Visible Layers Only: If one or more layers have been made invisible, they will not be 
exported.

Export All layers: All layers will be exported, whether or not they are visible.
(the two items above will be "grayed out" if "Export Entire Plan to One DXF Layer" is checked)

NOTE:  Home Plan Pro draws your plan in the DXF format according to your current zoom setting.    The 
more you zoom in, the larger the dxf plan will be.    
You may want to experiment with different zoom settings. 



Preferences Figures

Load Predrawn Figures    You can load the predrawn figures on startup, causing a few second delay, or   
wait until a figure is needed before loading.

Font Height for Predrawn Figures Set the height of text in figures in pixels. The default is 9 pixels.

Expand Predrawn Figures    See also Expand Figures
This is primarily to address "Flipping" of plans with predrawn figures.
If the figures are expanded, they will flip properly. Unexpanded, they are rotated 180 degrees instead.

You can choose to: 
      Expand each figure when inserted 
      Expand a figure before it is "flipped" 
      Never automatically Expand figures 
      Ask before flipping a figure 
"Never automatically Expand figures" is the default. 

Scale Pre-drawn Figures to Metric
Many Predrawn figures are sized to be a pre-determined size in the US drawing mode.
When switching to metric mode, a different resolution is used 
(each screen pixel = 25mm instead of one inch).

You can scale the figures to be their original size when drawing in metric mode.



Flipping Predrawn Figures
Available from the Preference "Figure" tab

Drawing coordinates for pre-drawn figures are stored in 
a Figure file, rather than in the plan file. The plan file 
just stores which figure to use and it's size, rotation, 
and location. 
"Flipping" the coordinates would alter all instances of 
that figure. 

The default solution is to rotate the figure 180 
degrees. That's the default, but sometimes this isn't 
what you want to see. 

The foolproof solution is to "Expand" the figure into 
individual drawing elements that can be flipped. 

There is a setting on the "Figure" tab of the 
Preferences screen. You can choose: 
      Expand each figure when inserted 
      Expand a figure before it is "flipped" 
      Never automatically Expand figures 
      Ask before flipping a figure 
"Never automatically Expand figures" is the default. 



Metes and Bounds
Available from the AutoDraw menu        What are "Metes & Bounds?

Enter a Distance for the line segment
Select a Direction
Enter the Degrees
Enter the Minutes if applicable
Enter the Seconds if applicable
Select the Bearing
Click the "Add to List" button to add to the Metes & Bounds list.
(Use the shortcut keys as a shortcut for cardinal directions)

When the list is complete, click the "Draw List to Plan" button to draw the plot.
Use the "Calculate" menu item to calculate the area before drawing.

· Note:      Metes & Bounds plots from your initial cursor position. Depending on that initial position and 
the plan size, the plot could end up partially off the drawing area.

If that happens, use the "Move Plan to Upper Left" item on the view menu to move the top left of the plot 
to the top left of the drawing area.

If the plot is too large for the zoom level to display, zoom out or use the Make Plan Fit Screen 
button.



Draw Dimension Between Walls
Available from the AutoDraw menu

· Select two parallel walls
· Click "Draw Dimension Between Parallel Walls"
· You are prompted to click on one wall where you want the dimension to start
· Select the type of dimension from the popup menu

A dimension will be drawn between the walls.



What are "Metes & Bounds?
See also Metes & Bounds

First lets be clear that no one here is a surveyor. We are software engineers implementing a surveying 
routine. We welcome comments and suggestions that would help make this subject more clear to our 
users.

Metes & Bounds are used to describe the shape and size of a plot of land.
It might be useful to take these "Metes & Bounds" off a deed or property description and draw a plot from 
them.
It might be useful to calculate the area and acreage of the described area.

Metes designates the distance of a line segment. In Home Plan Pro, the distance can be in feet/inches, 
Feet with decimals, or mm in metric mode.
Bounds indicates the angle of the line segment.
Bounds are made of three elements:

a Direction must be either North or South.
a Bearing must be either East or West.
an Angle in degrees between 0° and 90° You can also add Minutes and Seconds for more 

precision.

Example: 
N 00 E    500' = Due North
N 45 E    500' = North East
N 90 E    500' = Due East

You can see that this system covers two quadrants, or 180 degrees. Everything north of Due east and 
due west.



Metric mode Vs US mode
Switch modes from the Options menu or the Status Bar

You can draw in feet & Inches or in metric mode.
The program is designed to be used in one mode or the other. 
You should not mix modes in any one drawing.

Metric and US modes use a different scale. If that were not the case, 
each screen pixel would have to represent a difficult distance. You 
would have to move in increments of odd millimeters, or fractions of 
an inch. 

In Metric mode, each pixel represents 25 mm in the default drawing 
size.    In US mode, each pixel represents one inch in the default 
drawing size. 

If you just want to know what the true conversion would be, press the F9 key.
That will convert dimensions without changing modes.



Circle From Cursor Position
Available from Auto Draw Menu

· Click where you want the center of the circle
· Enter the radius of the circle.
· Click the Draw button



Ellipse From Cursor Position
Available from Auto Draw Menu

· Click where you want the center of the ellipse
· Enter the horizontal radius of the ellipse
· Enter the vertical radius of the ellipse
· Click the Draw button



Scale in Computer Assisted Drawing. 

There is no drawing scale when drawing in CAD.
There is only printing scale.
The size of the drawing on the screen has no effect on the scale that you use on your printouts.

"Scale" has no meaning in computer assisted drawing until print time.

Manual Drafting:
When drawing on paper by hand, printing begins with the first stroke of the pencil. The paper has to 
be chosen in advance so the plan will fit on the paper.

Not so in CAD:
All sizes and distances are specified using their full-scale values. 
A 10 foot object is drawn as a 10 foot object. 
When drawing in CAD, unlike in manual drafting, there is no need to determine in advance the paper
size and drawing scale.

Print Scale:
Only at the printing stage, does scale need to be determined based on paper size and the plan to be 
printed.

Feel free to select a zoom level that will show the most detail, if that's what you need, or zoom out 
to show a larger area of your plan. Press the "Fit Plan to Screen" button to show the full extent of 
your plan.
Your plan, and the future print scale are not affected by the zoom level you use to draw.



Authentication
See also: Email the Current Plan

A few internet service providers require you to provide your user ID and password to send email.
This is not necessary to send email using the "Dynamic DNS" method.
It usually isn't necessary when using the "Hostname" method.

If your internet service provider requires you to provide a user ID and a password to send email, click the 
Authentication menu item to enter that information.



Mouse Wheel Scrolling

If you have a mouse with a scroll wheel, you can use it to scroll the plan. 
· By default the plan scrolls vertically. 
· Hold down the Control key and the plan will scroll horizontally.



About CAD
Home Plan Pro was produced and is distributed by . . . Home Plan Software 8437 Center 
Street Mokelumne Hill, CA 95245 

Home Plan Pro is distributed as a free 30 day trial. We prefer this method because it allows 
you to fully explore all program options before buying. It is not fancy wrappings or trick 
advertising copy that sell Home Plan Pro; it is the performance of the program. 

What is CAD? CAD stands for Computer Assisted Design. Unlike painting or drawing 
programs, CAD applications represent real-world objects in their exact real-life dimensions. 

CAD programs use a "Vector Graphic" format to store the size and shape of objects such as 
houses or machines. Rather than filling an area with dots as a Paint program does, CAD 
programs store the actual measurements of the object. Scaling is a matter of multiplying 
these vectors by a scaling factor. This allows drawings by CAD programs to be completely 
accurate and to show as many details as necessary to produce the object. If you've used a 
drawing program such as Window's Paint, you may initially find CAD a little more difficult to 
use. That's part of the idea, everything is done accurately. The drawing doesn't only look 
accurate on the screen, it is accurate as a model. Moving an entity around means moving it 
from an exactly defined location to another exactly defined location. Once you get used to 
this approach, you will always want to do technical drawings using a CAD program. 

Why Home Plan Pro? Is Home Plan Pro the CAD program for you? It depends on what you
want to do. Home Plan Pro was designed to draw working plans quickly and easily. If you 
are looking for a 3D modeling application, you'll have to look somewhere else. Home Plan 
Pro is a 2D CAD program. That means that everything is projected onto a plane. That 
doesn't mean that it's only suitable to represent 2D objects though. Most working drawings 
are done in 2D. The typical architectural drawing is done in 2D. Architects, builders, and 
building inspectors prefer it that way. 

Why this one? Some of the reasons why you might want to use Home Plan Pro are its 
simplicity, Its ease of use, and its affordable price. There are many other capable CAD 
systems out there and many of them offer much more than Home Plan Pro does. But most 
of them are simply not affordable for many potential users, costing thousands of dollars, as 
opposed to Home Plan Pro's $39.00. Many CAD programs are designed for architects and 
engineers. Beside being expensive, They are hard to learn, and difficult to use. You must 
take classes to learn how to use them, and must use them every day lest you forget the 
complicated commands and routines. Home Plan Pro is designed to quickly and easily draw 
good-quality, straightforward designs. Home Plan Pro was first released by Home Plan 
Software in 1989. Although the program has evolved over the years, the price has not 
evolved, it's still $39.00. We still offer a 30 day free trial with no strings attached. We don't 
even take names. You download the installation, or run it from your browser, and you use 
the fully functional program for thirty days. If you don't want to keep it after 30 days, just 
delete it. To keep it, contact us and pay the $39.00. It's yours forever after that, and 
upgrades are free. 



Zoom Bar Buttons
See Also Zooming Scale in CAD 

If the Zoom Bar is not visible below the Drawing Area, turn it on from the View menu.

Each of the buttons with round dots select a zoom level. As the buttons approach the Plus sign, the plan 
becomes further "zoomed in". You will see a smaller area of the plan, but in greater detail.

As the buttons approach the minus sign, the pln becomes further "zoomed out". You will see more of the 
plan, but with less detail.

· Click the plus sign directly to cause the next higher zoom level to be selected.
· Click the minus sign directly to cause the next lower zoom level to be selected.

The distance assigned to each screen pixel at the current zoom level is shown in a label below these 
buttons 



Make Plan Fit Screen

See also Zooming

Click this button to make Home Plan Pro select the zoom level that will come closest to filling the visible 
drawing area.



Click on a Spot to Zoom
See also Zooming Continuous Click to Zoom

· After clicking this button, click a spot on the plan. The plan will be zoomed in to the next level. 
· The spot clicked will be in the center of the screen (or as close as possible if it's near a plan edge)

Note: Hold down the Shift key to zoom back out.
Note: Hold down the Control key to zoom three levels at a time.



Move Plan to Upper Left
See also Zooming Navigation

Click this button to view the upper left of the plan. The plan will be moved to the upper left of the drawing 
area if appropriate.
The zoom level is not changed. 

After several zoom changes, it's easy to lose perspective as to where you are in the plan.

This button and the Make Plan Fit Screen buttons can be helpful.



Screen Resolution
See also Zooming Zoom bar Scale in Computer Assisted Drawing

Zooming is accomplished by assigning a distance to each screen pixel.
If we assign one inch to each pixel, a line will be four inches long after moving four pixels.
If we assign 1/4 inch to each pixel, the line will be only one inch long.

This distance-per-pixel is shown in the Status Bar as "Screen Resolution"..



Snap Grid Settings
See also Snap Grid

Turn the snap action and grid visibility on/off independently.
Set the grid spacing for the current zoom level. (a setting is saved for each zoom level) 
See Snap Preferences for more ways to configure the snap grid.



Continuously Click on Spots to Zoom

See also Zooming Zoom Bar Buttons

· After clicking this button, click a spot on the plan.
The plan will be zoomed in to the next level. 
The spot clicked will be in the center of the screen (or as close as possible if it's near a plan edge)

Continue clicking and zooming until you select another tool or press the Escape key.

Note: Hold down the Shift key to zoom back out.
Note: Hold down the Control key to zoom three levels at a time.



Draw Parallel Lines

Available from the Drawing Tool Bar

Select the Parallel Line tool. Esc to quit.
 
With the mouse:
· Click to begin drawing the lines.
· Click to end drawing the lines.

With the keyboard:
· Position the cursor at the point at which the lines are to begin.
· Press Enter.
· Move the cursor with arrow keys to the end of the lines.
· Press Enter.

Repeat to continue drawing parallel lines. If the cursor is close to the end of the previous set, the lines will
be continued and the corners "cleaned up."

Hold down the Control key when terminating a set of parallel lines if you want the lines to be "closed" 

Press Escape to quit drawing parallel lines or select another tool
You can adjust the spacing between the lines.

More Info
· Lines are adjusted to level or plumb.
· To draw lines at an angle with the mouse, hold the Shift key down and draw as above.
· To draw lines at a 45 degree angle, follow the procedure above for drawing with keyboard, but use the

1, 3, 7, or 9 keys in the number pad.
· For better precision, use the arrow keys to position the cursor at the endpoints of the lines.
· Line length is shown in the Odometer at the left of the Status bar.
· The keyboard arrow keys move the cursor one pixel at a time.
· The Number Pad arrow keys move the cursor the distance assigned.    Adjust this distance by 

pressing the Plus and Minus keys.    The current distance is reported on the far right of the status bar.
· To connect the cursor to the end of an existing line, move close and press the Period key.
· See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element
Use the Select Line Style button to choose a new line style.



 Double Walled Rectangles
Available from the Drawing Tool Bar
See also Double Walled Rectangle Spacing
Select the Double Walled Rectangle tool.
Esc to quit.

With the mouse:
· Click a point at which a corner of the rectangle is to be located.
· Click the corner opposite.

With the keyboard:
· Position the cursor at a corner of the rectangle.
· Press Enter.
· Move the cursor with the arrow keys to the opposite corner.
· Press Enter.

        Continue drawing double walled rectangles or select another tool.

You can adjust the spacing between the walls.

More Info:
· The sides of the rectangle are adjusted to level or plumb.
· To draw a square, follow the procedure above for drawing with the keyboard, but use the 1, 3, 7, or 9 

keys in the number pad.
· For better precision, use the arrow keys to position the corners of the rectangle.
· The Dimensions of the rectangle are updated in the Odometers at    the left of the status bar as it is 

drawn.
· The keyboard arrow keys move the cursor one pixel at a time.
· The number pad arrow keys move the cursor the distance assigned.    Adjust this distance by pressing 

the Plus and Minus keys.    The current distance is reported on the far right of the status bar.

See also Connecting with Previous Elements

To alter an element already drawn, see: How To Select An Element



Double Wall and Parallel Line Spacing

Available from the Options menu or the Preferences "Drawing tab"

Set the distance to be used between parallel lines and double walled rectangles
Check the box if you want the beginning of first set of parallel lines to be closed.
(Press the Control key while terminating the last segment if you want its end closed)



Text Scaling Overview

See also Insert Text Detailed Print Preview    Print Preview Printed Text Scale Factor
Printed Text Size Limits On-Screen Printed Text Size Factor Text Scaling Options

Scaling text in architectural drawings is not a simple issue.
Three issues are involved:
· Text Readability
· Text Position
· Esthetic appearance

These issues are frequently in conflict depending on plan size, paper size, zoom level and other factors.
Home Plan Pro provides tools to try to resolve these issues.

Readability requires that text not be too big or too small.
Often a plan must be scaled considerably larger or smaller in order to fit on a particular size sheet

of paper.
If the text in a plan is scaled exactly the same as the rest of the plan, it may be too big or too 

small to be readable.
However, if the text is scaled differently than the rest of the plan, it may run into other drawing 

elements and the esthetics are adversely affected. 
For example: 
· Write "Closet" in a small closet
· Scale the plan 50%smaller
· Keep the text large enough to be readable
Now the text is "out of the closet" and leaks into the bedroom.

        

The answer esthetically, is to scale the text the same as the rest of the drawing. Then "Closet" will always 
be in the closet. But it may be too small to read.
The answer to make the text readable is to keep it within the readable size range. But then it might not fit 
in the space provided.

The following tools are provided to help:
· Detailed Print Preview
· Printed Text Size Factor
· Printed Text Size Limit
· Text Scaling Options



Detailed Print Preview
See also Insert Text Text Scaling Printed Text Printed Text Size Limits On-Screen Text

Print Preview

When you click the "Detailed Preview" button on the drawing screen's File menu, or the Print Control 
Screen, you will see an image of the printout according to the current settings.
Initially the image will be half-size. To get the best approximation of the actual printout, select 100% from 
the drop down list.

In the right hand panel you can select a value to apply to the printed text. Click on a value to see the 
results in the preview.
Also in the right hand panel is a button to set Printed Text Size Limits.

To save wasted paper and ink, use this feature prior to printing, unless you are sure the settings are 
correct.



Printed Text Scale Factor

See also Insert Text Text Scaling Printed Text Size Limits Print Preview Detailed Print 
PreviewText Scaling Options

Select a percentage to apply to text size on printouts.
You can access this setting from the "Printing" tab of the Preferences screen, but it is most useful when 
set from the Detailed Print Preview. That way you can see the results as you change the setting.

Only printed text is affected by this setting.



Printed Text Size Limits
See also Insert Text Text Scaling Detailed Print Preview Printed Text Scale Factor

On-screen text Text Scaling Options

Available from the Preferences Printing tab or the Detailed Print Preview screen.
When small plans are scaled larger, the text in those plans often gets too big to be readable and 
attractive.
You can set a limit beyond which printed text will not go. For instance: set the printed text Limit to 12 point
to assure that no text appears larger than 12 point on your printouts.

You can exempt certain text from this rule. You may want a title to appear larger than the limit:
· Select the text you want to exempt by clicking on it
· Click the "Exempt Selected text From Limit" button.

You can disable this limit by clicking the "Disable Text Size Limit" button.

Only printed text is affected by this setting.



On-Screen Text
See also Insert Text Text Scaling Print Preview Detailed Print Preview Printed Text 
Scale Factor Printed Text Size Limits

Frequently, when editing normal sized plans, you will want to zoom in on a part of the plan to get more 
detail.
The more you zoom in, the large everything gets. Including text.
It's normal, and desirable that this happen.

However, once in a while you might be zoomed in to draw something very small like drawing furniture, 
rather than to view part of a larger plan.
In such a case, you don't want to see huge text covering your plan.

Home Plan Pro tries to determine such cases and reduce the text size in those cases while letting the text
scale normally otherwise.



View All Text
Available from the Text Menu

All text elements are listed.
The attributes of the selected text are shown at the upper right.

· Click the "Edit" button to edit the text.
· Click the "Properties" button to see and change the element's properties.
· "Go To Element" selects the element and moves the cursor there.



Text Scaling Options
Available from the Preferences Drawing tab.

See also Insert Text Detailed Print Preview       Print Preview  Printed Text Scale Factor
Printed Text Size Limits On-Screen Text Printed Text Size Factor

Scaling Text to Drawing Size
· Automatic This is the default. Home Plan Pro decides
· Never Scale Text  text stays the same font size regardless of the drawing scale.
· Always Scale Text causes text to grow in proportion to the rest of the drawing.

We recommend the Automatic setting.
In some special cases, "Never Scale" can be useful. This is most often the case when using plans drawn 
in earlier versions.

Use the Automatic setting and the Detailed Print Preview to assure readable and esthically pleasing text 
on your printouts.



Text Columns
Available from the Text menu

You can select multiple text elements from anywhere on the plan and form them into a column.

· Drag and drop elements to re-arrange them in the list
· Select single or double spacing
· Click the "Create Column" button to move the text elements into a column.
· Move the column in place and double-click to anchor.



Scroll Bars

Picture of the horizontal scrollbar

· Click the black arrows to scroll the plan in the direction the arrows are pointing.

· Click the red arrow button to make room at the left or top of the plan.
For instance: You might want to add something to the left or top of the drawing, and there isn't room.

Click the red button
Draw in the newly created area
Use the Move Plan to Upper Left button to reclaim any extra space.



Plan Size Dialog

When you start a new plan, the Plan Size Dialog appears.

Select a size that will accomodate your new plan.
Home Plan Pro will select a zoom level that is compatible with your new plan.

You can change zoom levels at any time. You are not locked into any plan size. This dialog is just a 
convenient way to start in a compatible zoom level.

If you would rather have new plans just start a blank screen at the "default" zoom level, change the 
setting on the Preference's "General" tab.



Contiguous Walls
Available from Auto Draw Menu
Generate walls, each connected to the end of the previous.

· You are asked to click where you want the first wall to start.
· You are asked to select the angle and length.

The Wall is drawn. 
You may draw multiple walls from the end of the last wall. Click Cancel or escape to quit.



Draw French Doors

Available from the Auto Draw menu

Draw the first door by clicking on the Hinge, latch and opening position (See Doors).
The matching door is drawn automatically 



Print Scale Information
This button is on the Printing Screen

Look at the top of the screen to see information about the paper size and the real-world size of your plan.
The current selected scale is also shown.

The bottom of this screen allows you to select any scale and see what size paper will be required to print 
it.    The paper size includes the current margins set on the Printing screen.

The largest possible scale of the printout is determined by the actual size of the structure drawn and the 
size of the paper you are printing on.

To get a larger scale for a given drawing, you need to use larger paper. If your printer doesn't support 
larger paper, you can print on regular paper and have it enlarged at a copy/print shop. If you put 
something on the drawing four feet long, you can ask them to blow it up until it is one inch long. That will 
provide 1/4" per ft scale. 

See also: Printing Hints Print Problems Print Margins Printout too small
Print on Fanfold Paper



Put an Arrow in this Plan
Available from the AutoDraw menu

Click an arrow to insert it into your plan.    While positioning it in the plan, you can use the right mouse 
button to rotate it.
Click the left mouse button or press the Enter key to anchor the arrow in the plan.



Resize Selection by Percentage

Available from the Edit menu
See also: Re-size Drawing Element Select An Element Select A Group

· Select the elements to resize
· Enter a percentage
· Click the Accept button



Resize Selection by Percentage

Available from the Edit menu
See also: Re-size Drawing Element Select An Element              Select A Group

This will resize the entire plan and everything within it.
You should save the plan first, so you can go back to the original, if you don't like the result.

· Enter a percentage
· Click the Accept button



Error Dialog

Windows has multiple routines to raise many kinds of operational errors. Besides being irritating, such 
errors can affect the operation of your machine, perhaps even causing you to have to turn the machine off
and re-starting it.

· If you are connected to the internet, you can click a button and send us information to help us locate 
and trap errors when they arise. 

· If you like, you can type your email address so we can send you a reply.
· It can be very helpful if you also type a short description of what you were doing when the error 

occurred:
Example:      "I clicked the toolbar 'Copy' button to copy a selected line".

There are many kinds of errors. Often CAD programs suffer from math errors when scaling calculations 
result in numbers too big for the Windows math unit to handle.

We try to avoid errors altogether, and to trap those that do slip through.
When an error does occur, we display a dialog that may be able to send us information helpful in 
determining the cause.



Scalable pattern direction
From the Scaled Fill Pattern form.

Framing and Siding patterns can be switched between horizontal and vertical.
When such a pattern is selected, the Vertical/Horizontal radio buttons become activated.



Load Backed up File

Click this button to copy the selected plan to the /Data folder and to open it in Home Plan Pro.



Copy Selected Backup

You can copy the selected backup file to a destination you select.



Copy All Backups

You can copy all the backups in the list to a destination that you select.



Delete Selected Backup

You can delete the selected backup file.



Close Manage Backup Screen

This closes the Backup Management screen.



Backup List

This list holds each of your existing backups.
If the "Make a Backup Prior to Saving" checkbox is checked,
then the plan will be backed up to this list each time you save it, prior to saving.



previous version

see Manage Backups

Home Plan Pro backs up your plan before saving it. If the plan becomes corrupted, or if you have decided
that you want to cancel recent changes, you have access to the plan the way it was before you made 
those changes.
You can load the plan and compare it to the current version.

If you want the backup to match the current version, save it twice.



Zoom In

Zoom in to make the plan larger. You may need to scroll to see the entire plan



Zoom Out

Zoom Out to make the plan smaller so you can see more of the plan.



Save Plan to PDF File
Available from the File menu

The PDF File Screen allows you to select a scale that will be displayed in a PDF reader when shown at 
100% viewing size. The size of the PDF image is shown at the top of the form as you select a scale.

Check the "Show" checkbox to start the Adobe* Reader and display the file after it is created.
(Adobe Reader must be installed on your machine for this feature)

* Copyright © 2009 Adobe Systems Incorporated




